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Introduction
Microsoft Reporting Services is the component of Microsoft SQL Server 2008 that provides 
an enterprise-ready and extensible presentation layer for the Microsoft business intelligence 
platform . In its third release, Reporting Services continues its support for the three stages 
of the reporting life cycle, but it now includes several new features that improve the report 
 development, management, and delivery processes . The new tablix and chart controls give 
you more options for presenting data in a report, and the new server architecture makes 
it easier for administrators to manage server resources and for users to access and page 
through large reports . As you complete the step-by-step procedures in this book, you are 
introduced to these and other new features, in addition to all the other features that have 
made Reporting Services a popular choice for implementing a reporting platform in organi-
zations of all sizes since its initial release in 2004 .

When you have finished the book, you will know how to build reports using each type of 
structure supported by Reporting Services and how to enhance reports with interactivity 
and data visualization techniques . You use these reports to learn how to move reports from 
the development workstation to the server environment and how to manage and secure the 
 reports once they’re on the report server . Then you use these reports again to learn how 
 users can access reports online and subscribe to reports for delivery on a scheduled basis . 
You also learn how to build and use a report model for ad hoc reporting . If you have pro-
gramming skills, you can continue learning about the extensibility of Reporting Services by 
enhancing the reports with custom code, by developing tools to manage the report server, 
and by exploring techniques for integrating access to reports managed by Reporting Services 
into portals and custom applications .

Who	This	Book	Is	For
Because Reporting Services is a platform of technologies rather than a single application, 
a variety of people serving in different roles and having different skill sets all need to learn 
how to work with some aspect of Reporting Services . Whether you’re a report developer, IT 
administrator, or business user, you can use this book to learn how to perform the tasks for 
which you are responsible . If you’re completely new to Reporting Services, this book teaches 
you the fundamental concepts required to build, manage, and access reports . You need no 
prior experience with Reporting Services to use this book successfully . On the other hand, 
if you’re already familiar with an earlier version of Reporting Services, this book gives you a 
guided tour of the new features found in Reporting Services 2008 .
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Finding	Your	Best	Starting	Point	in	This	Book
Even if your primary responsibility with Reporting Services requires you to focus on only one 
component, you benefit from an understanding of all the capabilities that Reporting Services 
supports . For this reason, if you have time, you should work through the book from begin-
ning to end for the best experience .

Because this book can be used by readers with different needs, you can also choose to work 
through only the chapters that focus on your area of responsibility . Each part of the book 
contains related chapters in which the procedures are designed to build up your skills pro-
gressively and are necessarily interconnected . For the best experience, you should read all 
the related chapters and perform the steps in these chapters in sequence . Where applicable, 
instructions at the beginning of a chapter alert you to a requirement to complete procedures 
in a previous chapter before continuing . If you plan to read only about the features that ap-
ply to you, use the following table to find your best starting point .

If You Are Follow These Steps

A business user who wants 
to access managed reports 
online 

	 1.		 Install the sample files as described in the section entitled “Sample 
Files,” later in this Introduction .

	 2.		 Work through the first two chapters to learn about Reporting 
Services and to install it on your computer .

	 3.		 Complete Part IV, “Viewing Reports,” to learn how to access 
 reports that have been published to the report server .

A business user or report 
developer who uses  
report models for ad hoc 
reporting

	 1.		 Install the sample files as described in the section entitled “Sample 
Files,” later in this Introduction .

	 2.		 Work through the first two chapters to learn about Reporting 
Services and to install it on your computer .

	 3.		 Complete Chapter 9, “Developing Report Models,” to learn how 
to construct a report model, and Chapter 14, “Creating Ad Hoc 
Reports,” to learn how to develop ad hoc reports using a report 
model . Even if you’re a business user who is not responsible for re-
port model development, you should complete Chapter 9 to learn 
key concepts and terminology and to build the report model that 
you will need when developing ad hoc reports in Chapter 14 .

	 4.		 Review the remaining chapters in Part IV to learn how to access ad 
hoc and managed reports that have been published to the report 
server .
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If You Are Follow These Steps

A business user with some 
experience developing da-
tabase queries who devel-
ops managed reports

	 1.		 Install the sample files as described in the section entitled 
“Sample Files,” later in this Introduction .

	 2.		 Work through the chapters in Part I, “Getting Started with 
Reporting Services,” to learn about Reporting Services, to install it 
on your computer, and to learn how to use Report Builder 2 .0 .

	 3.		 Review the chapters that interest you in Part II, “Developing 
Reports,” to learn how to build more advanced reports . In many 
cases, you can adapt the procedures in these chapters for use with 
Report Builder 2 .0 .

	 4.		 Review the chapters that interest you in Part IV to learn how users 
access reports from the report server .

A report developer 	 1.		 Install the sample files as described in the section entitled “Sample 
Files,” later in this Introduction .

	 2.		 Work through the chapters in Part I to learn about Reporting 
Services, to install it on your computer, and to learn how to use 
Report Builder 2 .0 .

	 3.		 Complete Part II to learn how to use all the report development 
features available in Reporting Services .

	 4.		 Review the chapters that interest you in Parts III and IV to become 
familiar with overall functionality in Reporting Services .

	 5.		 If you have programming skills, complete Chapter 16, 
“Programming Reporting Services,” to learn how you can custom-
ize Reporting Services . 

A server administrator 	 1.		 Install the sample files as described in the section entitled “Sample 
Files,” later in this Introduction .

	 2.		 Work through Chapter 1, “Introducing Reporting Services,” and 
Chapter 2, “Installing Reporting Services,” to learn about Reporting 
Services and to install it on your computer .

	 3.		 Complete Part III to learn how to configure and manage the report 
server .

	 4.		 Review the chapters that interest you in Part IV to understand how 
users interact with the report server .

	 5.		 Skim Chapter 16 to discover how customization of Reporting 
Services might require changes on the report server and how to 
perform administrative tasks programmatically .

Conventions	and	Features	in	This	Book
This book presents information using conventions designed to make the information read-
able and easy to follow . Before you start, read the following list, which explains conventions 
you see throughout the book and points out helpful features that you might want to use .
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Conventions
n Each exercise is a series of tasks . Each task is presented as a series of numbered steps 

(1, 2, and so on) . A round bullet (•) indicates an exercise that has only one step .

n Notes labeled “Tip” provide additional information or alternative methods for complet-
ing a step successfully .

n Notes labeled “Important” alert you to information you need to check before 
continuing .

n Text that you type appears in bold.

n A plus sign (+) between two key names means that you must press those keys at the 
same time . For example, “Press Alt+Tab” means that you hold down the Alt key while 
you press the Tab key .

Other Features
n Sidebars throughout the book provide more in-depth information about the exercise . 

The sidebars might contain background information, design tips, or features related to 
the information being discussed .

n Each chapter ends with a section entitled “Quick Reference,” which contains brief 
 reminders of how to perform the tasks that you learned in the chapter .

Hardware	and	Software	Requirements
You’ll need the following hardware and software to complete the exercises in this book:

n Windows Vista Home Premium, Windows Vista Business, Windows Vista Ultimate, 
Windows Vista Enterprise, Windows Server 2003 Standard SP2, Windows Server 2003 
Data Center SP2, Windows Server 2003 Enterprise SP2, Windows Server 2008 Standard, 
Windows Server 2008 Data Center, or Windows Server 2008 Enterprise . The exercises 
also run using Microsoft Windows XP Professional SP2 .

n Microsoft SQL Server 2008 Standard, SQL Server 2008 Enterprise, SQL Server 2008 
Developer, or SQL Server 2008 Evaluation .

n Optional: Microsoft Windows SharePoint Services 3 .0 or Microsoft Office SharePoint 
Server 2007 .

n Optional: Microsoft Visual Studio 2008 Standard or Professional with either the 
Microsoft Visual Basic  .NET or Microsoft Visual C#  .NET library, and Visual Studio 2008 
Service Pack 1 .
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Note Visual Studio 2008 is required only to complete Chapter 16 . If you install it before 
you complete the other chapters, you will notice that the steps that you must follow to 
start a new project or to open an existing project will vary slightly from the steps written in 
those chapters . These steps were written with the assumption that you do not install Visual 
Studio 2008 until you reach Chapter 16 .

n 1 gigahertz (GHz) Pentium III+ processor, or faster, with 2 GHz recommended .

n 512 GB of available, physical RAM with 2 GB recommended .

n Video (1,028 x 768 or higher resolution) monitor with at least 256 colors .

n CD-ROM or DVD-ROM drive for installation from disc .

n Microsoft mouse or compatible pointing device .

You also need to have Administrator access to your computer to configure SQL Server 2008 
Reporting Services .

Sample	Files
The companion CD inside this book contains the sample files that you use as you perform the 
exercises . By using these sample files, you won’t waste time creating files that aren’t relevant 
to the exercise . The files and the step-by-step instructions in the lessons also let you learn by 
doing, which is an easy and effective way to acquire and remember new skills .

Digital Content for Digital Book Readers: If you bought a digital-only edition of this book, you can 
enjoy select content from the print edition’s companion CD. 
Visit http://www.microsoftpressstore.com/title/9780735626478 to get your downloadable content. This content 
is always up-to-date and available to all readers. 

Installing the Sample Files
Perform the following steps to install the sample files and required software on your 
 computer so that you can use them with the exercises .

	 1.	 Remove the companion CD from the package inside this book and insert it into your 
CD-ROM drive .

Note A license agreement should open automatically . If this agreement does not appear, 
open My Computer on the desktop or Start menu, double-click the icon for your CD-ROM 
drive, and then double-click StartCD .exe .

http://www.microsoftpressstore.com/title/9780735626478
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	 2.	 Review the license agreement . If you accept the terms, select the Accept option and 
then click Next .

A menu appears with options related to the book .

	 3.	 Click Install Practice Files .

	 4.	 Follow the instructions that appear .

The code samples are installed to the Microsoft Press\Rs2008sbs folder in your 
Documents folder on your computer . If your computer’s operating system is Windows 
Vista or Windows Server 2008, your Documents folder is located at C:\Users\<login>\
Documents, where <login> is your login name . If the operating system is Windows 
XP or Windows Server 2003, your Documents folder is located at C:\Documents And 
Settings\<login>\My Documents .

Using the Practice Files
Each chapter in this book explains when and how to use any practice files for that chapter . 
When it’s time to use a practice file, the book lists the instructions for how to open the files .

Uninstalling the Code Samples
Perform the following steps to remove the code samples from your computer .

	 1.	 In Control Panel, open Add Or Remove Programs .

	 2.	 From the list of Currently Installed Programs, select Microsoft SQL Server 2008 
Reporting Services Step by Step .

	 3.	 Click Remove .

	 4.	 Follow the instructions that appear to remove the code samples .

Find	Additional	Content	Online
As new or updated material becomes available that complements your book, it will be posted 
online on the Microsoft Press Online Developer Tools Web site (www.microsoft.com/learning 
/books/online/developer) . The type of material you might find includes updates to book 
 content, articles, links to companion content, errata, sample chapters, and more . This Web 
site is updated periodically .
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Support	for	This	Book
Every effort has been made to ensure the accuracy of this book and the contents of the 
companion CD . As corrections or changes are collected, they will be added to a Microsoft 
Knowledge Base article .

Microsoft Press provides support for books and companion media at the following Web site:

http://www.microsoft.com/learning/support/books/

Questions and Comments
If you have comments, questions, or ideas regarding the book or the companion CD, or 
questions that are not answered by visiting the sites above, please send them to Microsoft 
Press via e-mail to

mspinput@microsoft.com

Or via postal mail to

Microsoft Press 
Attn: Microsoft SQL Server 2008 Reporting Services Step by Step Editor 
One Microsoft Way 
Redmond, WA 98052-6399

Please note that Microsoft software product support is not offered through the preceding 
addresses .
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Chapter 4

Designing Reports
After completing this chapter, you will be able to:

n Create a report server project in Business Intelligence Development Studio .

n Add a new or existing report to a report server project .

n Add a shared data source to a report server project .

n Define a dataset .

n Design a report using data regions and report items .

n Group and total data in a data region .

n Embed a report in another report as a subreport .

n Use properties to define placement and appearance of report items .

n Define page breaks and set properties related to paging .

n Add report items to the page header and page footer .

In this chapter, you learn how to use Report Designer in Business Intelligence Development 
Studio (BI Dev Studio) to develop reports . Many of the principles that you have already 
learned about using Report Builder 2 .0 are also applicable to using Report Designer, so you 
can use either tool comfortably when you finish this chapter . You start by preparing a report 
server project to contain your reports and creating a data source and dataset to provide data 
for your report . Then you learn a variety of techniques for structuring data in a report and 
enhancing the appearance of your report . 

Getting	Started	with	Report	Designer
Before you start report development using Report Designer, you must first perform some 
tasks to prepare the environment . Whereas Report Builder 2 .0 supports development of one 
report at a time, as explained in Chapter 3, “Exploring Reporting Services,” the integrated 
development environment in BI Dev Studio allows you to work with multiple reports in the 
same environment . You use a report server project as a container to store these reports in 
a common location . Another difference from Report Builder 2 .0 that you encounter when 
 using BI Dev Studio is the ability to create a shared data source to store data source con-
nection information independently of the reports . After creating a shared data source, you 
define the query used to extract data from the source for display in the report . After finishing 
these tasks, you’re ready to start developing reports .
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Creating a Report Server Project
BI Dev Studio is a Microsoft Visual Studio shell program that provides many of the features 
of Visual Studio without requiring you to purchase and install Visual Studio . If you’re new to 
the Visual Studio integrated environment, don’t worry . You don’t need to be a programmer 
to use this tool effectively . Before you start report development, you must create a report 
 server project, which is a folder created to store a set of reports and shared data sources . 
When you create a new report server project, you defi ne the location for this folder and a 
name for the solution to contain the report server project . A solution is simply a container 
for one or more projects, which can be any combination of project types supported by Visual 
Studio, including a report server project .  

In this procedure, you create a report server project in BI Dev Studio . 

Create a report server project

	 1.	 Click Start, select All Programs and Microsoft SQL Server 2008, and click SQL Server 
Business Intelligence Development Studio . 

	 2.	 On the File menu, point to New, and click Project . 

	 3.	 In the New Project dialog box, in the Templates pane, select Report Server Project . 

When you create a new project, you have three templates from which to choose: 
Report Server Project Wizard, Report Server Project, and Report Model Project . You 
can use the Report Server Project Wizard to accelerate basic report design using a 
wizard interface . (To learn more about the Report Project Wizard, refer to the sidebar, 
“Using the Report Project Wizard,” later in this chapter .) To meet specifi c report design 
requirements, however, you will likely fi nd it better to use the Report Server Project as 
you learn how to do in this procedure . You learn how to use the Report Model Project 
in Chapter 9, “Developing Report Models .” 

	 4.	 In the Name box, type Sales . 

	 5.	 In the Location box, type C:\Users\<Username>\Documents\Microsoft	Press
\Rs2008sbs\Workspace, as shown here . 

 Note If you’re using Microsoft Windows XP or Windows Server 2003, navigate to 
C:\Documents and Settings\<Username>\My Documents\Microsoft Press\Rs2008sbs
\Workspace . 

Create a report server project
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	 6.	 Click OK . 

Using	the	Report	Project	Wizard
The Report Project Wizard walks you step by step through the report development 
process . You defi ne an embedded or shared data source, provide a query string,  select 
a report layout, defi ne groupings, and apply a style to set colors and fonts for the 
report . The wizard limits you to using a tabular or matrix layout . However, after the 
 report is created, you can continue to fi ne-tune the report to meet your specifi cations .  

Adding a Report to a Project
Now that you have a report server project ready, you can add a report to your report server 
project by using the Report Project Wizard, adding a new report manually, or importing a 
report from Microsoft Offi ce Access . 

In this procedure, you add a report to your report server project . 

Add a report to a report server project

	 1.	 In Solution Explorer, right-click the Reports folder, select Add, and click New Item . 

You might be tempted to click the Add New Report command on the context menu for 
Reports, but this command starts the Report Project Wizard . The Report Project Wizard 
is useful for quickly producing a basic report, but most report developers prefer to 
build a report manually .  

Add a report to a report server project
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	 2.	 In the Templates pane, select Report .

In addition to the Report template, the list of available templates includes the Report 
Project Wizard and Data Source templates . The Report Project Wizard template 
 produces the same result as using the Add New Report command from the Reports 
context menu . Similarly, the Data Source template displays the same dialog box as the 
Add New Data Source command in the Shared Data Sources context menu .

	 3.	 In the Name box, type Reseller	Sales	Summary.rdl, and click Add .

Note You must provide the file extension  .rdl for the file you are adding to the report 
server project . 

After you click Add, the report appears in the solution and Report Designer displays in 
the document window .
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Before continuing to develop your report, take a few moments to become familiar with 
the layout of the design environment:

n Toolbox The Toolbox window is hidden by default when you first open a report and 
appears only as a tab on the left side of the window . The Toolbox window is similar to 
the Ribbon in Report Builder 2 .0 introduced in Chapter 3 . You use this window to add 
controls that define your report layout .

n Report Data The Report Data window displays to the left of the report layout . It 
 contains three folders: Built-in Fields, Parameters, and Images . You use Built-in Fields to 
add commonly used expressions, such as ReportName or PageNumber, to your report . 
You learn how to work with the Parameters folder in Chapter 6, “Adding Interactivity .” 
The Images folder stores images you use in the report, as you do later in this chapter . 
After you add a data source and a dataset to your report, these objects display in the 
Report Data window as well . Thus, the Report Data window organizes many of the key 
items you use within your report .

n Report Designer The Report Designer occupies the central window in the develop-
ment environment and consists of two tabs . On the Design tab, you arrange the layout 
of data and graphical elements on your report . On the Preview tab, you can test the 
rendering of the report to different formats without first deploying your report to the 
report server . The Grouping pane appears at the bottom of the Report Designer win-
dow and displays a hierarchical view of groups defined for a selected data region . 

n Solution Explorer This window appears to the right of Report Designer and displays 
the files associated with each project within your solution . 

n Properties Each item you add to the report, as well as each area of the report (such 
as the body, page header, page footer, and even the report itself), has a set of proper-
ties to define its appearance and behavior . When you select an item or report area in 
Report Designer, you see its related properties in the Properties window, which displays 
to the right of Report Designer . 

You can rearrange these windows while developing your report to give more space 
to Report Designer or to access items better in a window . For example, you can use 
the Auto Hide feature to minimize the Toolbox, Report Data, Solution Explorer, or 
Properties window . You can also undock a window from its default location and drag it 
to a new location . 



108 Part II Developing Reports

	 4.	 Point to the Toolbox tab on the left side of the window, and then click the Auto Hide 
button (which looks like a pushpin and is displayed next to the Close button for the 
window) to open and lock the Toolbox window, shown here .

Notice that the Toolbox overlays the Report Data window to conserve the amount of 
space used on your screen . You use the tabs at the bottom of the current window to 
switch to the other window .

	 5.	 Click the Report Data tab to switch the visible window .

Instead of using the Auto Hide feature, you can close a window to maximize screen 
space for the Report Designer .

	 6.	 In the upper-right corner of the Report Data window, click the Close button (which 
 appears as an X) .

At any time, you can open a closed window by using the View menu .

	 7.	 On the View menu, click Report Data .

Creating a Data Source
A report requires a data source to identify where the data for the report is found and how 
the user is authenticated to determine whether permissions exist to retrieve the report data . 
You can choose to embed a data source within the report or to use a shared data source that 
is available to multiple reports . By using a shared data source, you can maintain connection 
and authentication information in a single location, which is generally the recommended 
 approach . However, if you need to use a dynamic data source, such as when you need to use 
different servers for different users, then you must use an embedded data source .



 Chapter 4 Designing Reports 109

In this procedure, you create a shared data source for the AdventureWorksDW2008 database .

Create a shared data source

	 1.	 In the Report Data window, click New, and then click Data Source . 

	 2.	 In the Data Source Properties dialog box, in the Name text box, type 
AdventureWorksDW2008.	

 Note When you defi ne a name for a data source, you cannot include spaces in the name 
and you must use a letter as the fi rst character . 

You can choose either to create an embedded connection or to use a shared data 
source reference . When you use an embedded connection, you can defi ne an explicit 
connection string, as you did in Chapter 3, or you can click the Expression button (to 
the left of the Edit button) to build a dynamic connection string, which you learn how 
to do in Chapter 5, “Developing Expressions .” 

	 3.	 Select Use Shared Data Source Reference, and click New .

 Note Because no shared data sources exist in the report server project, you must create a 
new data source before you can select a reference . 

	 4.	 In the Shared Data Source Properties dialog box, in the Name text box, type 
AdventureWorksDW2008.	

	 5.	 Open the Type drop-down list, review the available data providers, and select Microsoft 
SQL Server . 

You can choose from the following data providers: Microsoft SQL Server, Object 
Linking and Embedding Database (OLE DB), Microsoft SQL Server Analysis Services, 
Oracle, Open Database Connectivity (ODBC), Extensible Markup Language (XML), 
Report Server Model, SAP NetWeaver BI, Hyperion Essbase, and Teradata . You must 
supply a connection string applicable to the selected data provider . If the Edit but-
ton is available after you select a data provider, you can use it to open the Connection 
Properties dialog box, which provides a graphical interface that prompts you for the 
properties required to construct the appropriate connection string . 

	 6.	 Click Edit . 

	 7.	 In the Connection Properties dialog box, in the Server Name text box, type localhost . 

	 8.	 In the Select Or Enter A Database Name drop-down list, select 
AdventureWorksDW2008, and click OK . 

	 9.	 In the Shared Data Source Properties dialog box, click Credentials . 

Create a shared data source
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As you learned in Chapter 3, you must specify whether the report uses Windows 
authentication to pass through the current user’s credentials, a hard-coded value for 
user name and password, a prompt at report execution to request the user to enter 
credentials, or no credentials at all . Unless the data source has no security defined, 
which is highly unusual, the credentials are used by the data source to authenticate the 
user before the query executes . Accordingly, the user account must have at least Read 
permissions on the data source .

	 10.	 Click OK to close the Shared Data Source Properties dialog box .

Notice that the AdventureWorksDW2008 .rds file has been added to the Sales 
solution in the Shared Data Sources folder in the Solution Explorer window . 
AdventureWorksDW2008 .rds is an XML file containing all the information required to 
connect to the data source . The shared data source deploys to the report server when 
you deploy the report, as you learn in Chapter 10, “Deploying Reports to a Server .”

	 11.	 In the Data Source Properties dialog box, in the Use Shared Data Source Reference 
drop-down list, select AdventureWorksDW2008, as shown here .

Notice the Use Single Transaction When Processing The Queries check box at the bot-
tom of the dialog box . You should select this check box when your report contains 
multiple datasets that reference the same shared data source and your data source 
cannot handle several parallel connections, or if you want the queries to execute as a 
single transaction . In other words, when this option is selected, if one query to the data 
source fails, then all queries to the same data source should also fail . If you leave this 
check box cleared, then the dataset queries execute in parallel . 

	 12.	 Click OK to close the Data Source Properties dialog box .



 Chapter 4 Designing Reports 111

Notice that the data source now appears in the Report Data window . This data source 
is actually a pointer to the data source fi le that you see in Solution Explorer . If you 
later change connection information in the shared data source fi le, you won’t need to 
update the connection in your report because your report automatically uses the new 
connection information . 

Creating a Dataset
As you learned in Chapter 3, a dataset defi nes a query for your report and contains the fi eld 
list of data columns returned by the query . The Dataset Properties dialog box allows you to 
use a query designer for supported data sources, such as SQL Server or Analysis Services, 
to build the query text or to import the query text from a fi le saved on your computer 
or  network . You can also test the query to be sure you’re retrieving the right data before 
 developing your report .  

In this procedure, you add a dataset to return reseller sales amounts grouped by sales terri-
tory and by business type for the calendar year 2004 . 

Add a dataset

	 1.	 In the Report Data window, click New, and then click Dataset . 

	 2.	 In the Dataset Properties dialog box, in the Name text box, type ResellerSales.	

As with a data source, your dataset name cannot include spaces and must have a letter 
as the fi rst character . 

Notice that the data source is already selected . If you have multiple data sources 
 defi ned in your report, then you must be sure to select the correct data source . You 
also have the option to create a new data source at this time if you skipped that step 
before attempting to create a dataset . 

If you plan to write your own query, select Text as the query type, which is the default . 
Many database administrators prefer that reports use stored procedures to retrieve 
data from a database . When you select Stored Procedure as the query type, a list of 
available stored procedures displays in a drop-down list from which you make a selec-
tion . If you are using an OLE DB or ODBC data provider to connect to a SQL Server 
database, you can select Table as the query type to use the TableDirect feature of SQL 
Server to return all fi elds within a table .  

 Instead of providing static query text for a dataset, you can construct a query dynami-
cally by specifying an expression . You learn how to do this in Chapter 5 . 

	 3.	 Click Query Designer . 

	 4.	 On the toolbar, click Import . 

Add a dataset
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	 5.	 In the Import Query dialog box, navigate to the Microsoft Press\Rs2008sbs\Chap04 
folder in your Documents folder, and double-click ResellerSalesSummary2004 .sql . This 
query retrieves sales for each sales territory group, sales territory country, and reseller 
business type for the calendar year 2004 .

	 6.	 On the toolbar, click the Run button (which displays as an exclamation point) to run the 
query, as shown here .

You can edit the query text if you need to make changes before saving the dataset 
query . 

	 7.	 On the toolbar, click Edit As Text to disable the text editor and view the Query 
Designer .

Tip If you prefer a GUI, you can click Edit As Text to toggle to the Query Designer if it’s 
supported by the selected data provider .
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	 8.	 Click OK to close the Query Designer window and return to the Dataset Properties, as 
shown here .

You can specify a time-out value in seconds to end execution if the query cannot exe-
cute within a fixed period of time . If you clear the value from the Time Out (In Seconds) 
box so that it’s empty, the query never times out .

Notice also that the Dataset Properties dialog box has several other tabs, as follows:

n Parameters You can provide default values for query parameters if they are sup-
ported by the data source . These default values can alternatively be linked to report 
parameters, which you learn about in Chapter 6 .

n Fields In addition to fields retrieved for the dataset by executing the query, you can 
define calculated fields, which you learn about in Chapter 5 .

n Options You can specify options for your data, such as collation, case sensitivity, 
 accent sensitivity, kanatype sensitivity, and width sensitivity . This page also includes an 
option for specifying whether subtotal rows in your dataset should be treated as detail 
rows in your report, which is explained in more detail in Chapter 7, “Using Analysis 
Services as a Data Source .”

n Filters If you are unable to filter data at the data source by using a WHERE clause in 
your query, you can filter the data in the dataset by defining filter rules . You learn how 
to use filters in Chapter 6 .
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		 9.	 Click OK to close the Dataset Properties dialog box . 

The dataset appears in the Report Data window as a node of the 
AdventureWorksDW2008 data source . Notice the fi elds below the data set, as shown 
here . Each fi eld is a column returned by the query for this dataset . 

Designing	the	Report	Structure
Now that you have completed the preparation for report development, you’re ready to start 
designing the layout of data on the report . You use one or more data regions to  present 
data in a structured or unstructured format in the report layout . As you work, you can switch 
to Preview mode to confi rm you’re achieving the desired results . Your report specifi ca-
tions might require you to defi ne groupings and totals, add supporting elements such as 
a text box, line, or image, or even embed another report within the report you’re currently 
developing .  

Adding a Data Region
A data region is the primary report item that you use to display data in your report . 
Reporting Services provides four different data regions: tables, matrixes, lists, and charts . You 
link a data region to a single dataset and specify how fi elds in that dataset are positioned 
within the data region .  

To start your fi rst report, you use a table . A table has a fi xed number of columns, and the 
number of detail rows depends on the number of rows returned by the dataset query . Much 
as a spreadsheet is a collection of cells, a Reporting Services table is a collection of text boxes 
organized as rows and columns . You can defi ne a header row in a table for column labels or 
a footer row for aggregated values . To organize detail rows better, you can add groups and 
defi ne subtotals for these groups .  

In this procedure, you add a table to the report design .

Add a table

	 1.	 In the Toolbox window, double-click Table to add it to the design surface, or you can 
drag the table from the Toolbox to the design surface . 

Add a table
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 Tip If you can’t see the Toolbox window, click the Toolbox tab on the left if the window 
is currently confi gured to Auto Hide, or click the Toolbox tab at the bottom of the Report 
Data window if the window is currently confi gured as a tabbed document . If you still can’t 
see the Toolbox window, use the View menu to open the Toolbox window . 

When you double-click a control in the Toolbox window, the control is placed as near 
the upper-left corner of the design surface as possible . You can be more specifi c with 
the placement of the control if you drag it from the toolbox to the desired location . 

The default table includes three columns . You can add or remove columns to meet your 
requirements . 

	 2.	 Right-click the top row of the third column, and click Delete Columns . 

Now your table has two columns that you can use to display Business Type and Sales 
Amount from the ResellerSales dataset . 

Binding Data to a Data Region
A data region must be bound to a dataset so that you can position fi elds from that 
 dataset within the data region . To associate a dataset with a data region, you can set the 
DatasetName property for the data region or you can drag a dataset fi eld from the Report 
Data window to a text box in the data region . After you have bound a data region to a 
 dataset, you cannot add fi elds from a different dataset to that data region .  

In this procedure, you add fi elds to your table . 

Add fi elds to a table

		 1.	 Open the Report Data window, and then drag the BusinessType fi eld to the second row 
of the fi rst column, as shown here . 

When you add a fi eld to a detail row in a table, Report Designer displays the fi eld name 
in the column header automatically . You can change the text if you prefer a different 
label . If the fi eld’s data type is numeric, the text box automatically is right-justifi ed . 

Add fi elds to a table
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Tip If you place data in a wrong field, or do anything you didn’t intend, for that matter, 
click the Undo button on the toolbar to revert to the previous state of your report . This 
 action undoes the last action that you performed, so you need to do it immediately after 
you recognize your error . You can undo up to your last five actions .

	 2.	 Point to the second row of the second column, click the Field List icon, and click 
SalesAmount .

You can either drag fields from the Report Data window or use the Field List to select a 
field from the dataset bound to the data region . By adding BusinessType to the table, 
you bound the ResellerSales dataset to the table .

	 3.	 In the Properties window, open the drop-down list at the top of the window, select 
Tablix1, and scroll to locate the DataSetName property in the General section to 
 confirm the binding to the ResellerSales dataset .

Note You might be wondering why the data region is called a tablix here rather than a 
table, but first it’s important to develop an understanding of data regions in general . You 
learn more about the tablix later in this chapter .

	 4.	 Click the Preview tab to view the report, as shown here .

Notice the repetition of the business types: Specialty Bike Shop, Value Added Reseller, 
and Warehouse . Each row in the table is a detail row and reproduces the same 
 sequence of rows that you saw when you executed the dataset query in a previous pro-
cedure in this chapter . In the dataset, these detail rows are grouped by sales territory 
group and country . You’ll also add these groups to your table in the next procedure .

	 5.	 Close the Output window .
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Each time you preview your report, the Output window appears . Any errors or warn-
ings display in this window to alert you to problems to be corrected in your report . This 
window stays open even when you switch back to the Design tab, but you can close it 
at any time .  

Previewing	a	Report	in	Report	Designer
You can preview a report without fi rst deploying it to a server to make sure it looks the 
way you intend for online viewing . You also can use the Print Layout button to see how 
the printed version of the report will look, which is an important step to remember . 
Commonly, new report developers focus on a report design that looks great online, 
but they forget to check the print version . A data region might render across multiple 
pages unintentionally or blank pages might appear—problems that become evident 
only when you print or export the report while in Preview mode .  

The Preview toolbar includes several buttons to test your report . Use the Page Setup 
button to defi ne page size, orientation, and margins, and then use the Print button 
to send your report to a printer . Be sure to test rendering to other formats by using 
the Export button to view the report in XML, Comma-Separated Value (CSV), Tagged 
Image File Format (TIFF), Portable Document Format (PDF), MIME Encapsulation of 
Aggregate HTML Documents (MHTML), Microsoft Offi ce Excel, or Microsoft Offi ce 
Word formats . 

Grouping Data
You can use groups to combine detail rows into related sets, and you can include subtotal 
values as an aggregation of numeric fi elds in the detail rows . For a table, you defi ne row 
groups only . You can right-click a text box in a data region to create a new group, and then 
select a dataset fi eld to use for grouping, or alternatively defi ne an expression . 

You can see groups in the Grouping pane at the bottom of Report Designer . This Grouping 
pane makes it easier to see which groups are defi ned for the data region and, if multiple 
groups are defi ned, how the groups relate to one another hierarchically . Furthermore, in the 
Grouping pane, you can access properties for each group or add additional groups easily . 

In this procedure, you add groups to your table . 

Group data in a table

	 1.	 Click the Design tab . 

	 2.	 Right-click the second row of the fi rst column, select Add Group, and then, in the Row 
Group section, click Parent Group . 

Group data in a table
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There are also options to add a column group or an adjacent group . You learn more 
about working with these other group types later in this chapter .

	 3.	 In the Tablix Group dialog box, in the Group By drop-down list, select 
[SalesTerritoryGroup], as shown here .

You have the option to add a header or footer for the group . When you choose these 
options, rows are added to the table above and below the details row . For this report, 
you are creating a more compact table and will not use header and footer rows for 
each group .

	 4.	 Click OK to close the Tablix Group dialog box .

Notice that the group appears in a new column to the left of the existing columns, as 
shown here . A default column label, Group1, also displays, which you can change, of 
course .

	 5.	 Right-click the second row of the first column (containing [SalesTerritoryGroup]), select 
Add Group, and then, in the Row Group section, click Child Group .

When you add a group to a data region that already contains at least one group, you 
must decide how the groups will relate to each other . If the new group will contain the 
existing group or detail rows, you create a parent group . If the new group will be con-
tained by the existing group, you create a child group, as you did here .

	 6.	 In the Tablix Group dialog box, in the Group By drop-down list, select 
[SalesTerritoryCountry], and click OK .
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The labels for the groups default to Group1 and Group2, as shown here, which you can 
change by replacing the text in the table header row .

	 7.	 Click in the first row of the first column, highlight Group1, and type Group .

	 8.	 Click in the first row of the second column, highlight Group2, and type Country .

Note Changing the labels does not change the name of the groups in the Grouping pane . 
Instead, you must access the Group properties to change the group names to identify 
them more easily in the Grouping pane .

Tip Although you are not required to provide names for the groups yourself, you will find 
it helpful to use a more meaningful name than the default generic name when multiple 
groups display in the Grouping pane .

	 9.	 In the Grouping pane, right-click Group1, and click Group Properties .
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	 10.	 In the Group Properties dialog box, in the Name text box, type SalesTerritoryGroup,	
as shown here .

Note Group names, like data source and dataset names, cannot contain spaces and must 
start with a letter .

Notice that you can define multiple group expressions for a single group by clicking 
Add and selecting a new field . Instead of using a dataset field as a group expression, 
you can construct a formula expression for grouping . You learn more about expressions 
in Chapter 5 .

You can define many other types of properties for each group: Page Breaks, Sorting, Filters, 
Variables, and Advanced . You learn more about Page Breaks and Sorting later in this chapter . 
Defining a filter for a data region is similar to defining a filter for a dataset, except that the 
data region filter applies only to the data region . You learn more about group variables in 
Chapter 5 and about the options on the Advanced tab in Chapters 5 and 6 .

	 11.	 Click OK to close the Group Properties dialog box .

	 12.	 In the Grouping pane, right-click Group2, and click Group Properties .

	 13.	 In the Group Properties dialog box, in the Name box, type SalesTerritoryCountry, and 
click OK .

Tip From time to time, it’s a good idea to save your work . Notice the asterisk on the 
Report Designer tab . The asterisk lets you know that you have made changes to the report 
that you have not yet saved to disk, and it disappears when you save your report .
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	 14.	 On the File menu, click Save, or click the Save Selected Items button on the toolbar . 

	 15.	 Click the Preview tab to view the current state of your report, as shown here . 

Adding a Total
When you use a table in your report, you can use the Add Total command to add a row 
to sum detail rows for a group, or for the entire table . By default, the Add Total command 
 inserts an expression using the Sum() function, but you can change the expression to use an 
alternative aggregate function such as Average() or Min() . You learn more about aggregate 
functions in Chapter 5 . 

 In this procedure, you add totals for each group in your table . 

Add totals to row groups

		 1.	 Click the Design tab . 

		 2.	 Right-click the text box containing [SalesAmount], and click Add Total . 

 A new row appears as a group footer row for the SalesTerritoryCountry group . 

		 3.	 Click the new text box containing [Sum(SalesAmount)], as shown here . 

Add totals to row groups
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When you click a text box containing an aggregate function, an orange bar appears 
to the left of the row group to which the aggregate function applies . In this case, the 
sum of the Sales Amount column entries represents the sum of all sales amounts for the 
SalesTerritoryCountry group .

	 4.	 Right-click the text box containing [Sum(SalesAmount)], and click Add Total .

When you apply the Add Total command to a group total, Report Designer adds 
another group footer row for the total of the parent group, which in this case is the 
SalesTerritoryGroup . Because SalesTerritoryGroup has no parent group, a label for Total 
displays in the new group footer row .

Notice also the icons in the row handles on the left side of the table . The set of three 
horizontal lines identifies the detail row . The line spanning the second and third rows 
of the table shows the scope of the innermost group, SalesTerritoryCountry, and the 
line spanning the second, third, and fourth rows of the table shows the scope of the 
SalesTerritoryGroup group . These visual cues are helpful when you add many groups 
and multiple rows per group to a table .

	 5.	 In the text box to the left of [Sum(SalesAmount)] in the group footer row of the 
SalesTerritoryCountry group (in the third row of the third column), type Country	Total .

	 6.	 In the SalesTerritoryGroup group footer row, replace Total by typing Group	Total	in the 
text box .

	 7.	 Click Save Selected Items, and then click the Preview tab to view the report, as shown 
here .
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Reviewing	the	RDL	File
The purpose of Report Designer is to provide a graphical interface for the construc-
tion of a Report Defi nition Language (RDL) fi le, which is an XML representation of your 
report using Report Defi nition Language, an open schema developed by Microsoft . 
Instead of reports stored in a proprietary format that can be used only within specifi c 
applications, Reporting Services allows you to create a report defi nition to describe the 
report’s data query, fi elds, layout, properties, and so on . The report defi nition describes 
how to get the data required for the report and what the fi nal report should look like, 
but not how to produce it .  

You can view the RDL of your report at any time . In Solution Explorer, right-click the 
report, and click View Code . You can make edits to the RDL in Code view, but be care-
ful . If you inadvertently remove a required tag, you can no longer work with the report 
in Report Designer . Be sure to make a copy of your report before modifying the RDL as 
a safeguard . 

Using a Matrix
Another type of data region that you will fi nd useful is a matrix . Whereas a table has a fi xed 
number of columns and a dynamic number of rows, both the rows and columns of a matrix 
are dynamic . A matrix displays data in a structure much like a crosstab or pivot table, and can 
use groups on either rows or columns with optional subtotals . 

In this procedure, you add a matrix to your report  .

Add a matrix 

	 1.	 Click the Design tab . 

You can reuse the same dataset in multiple data regions on your report, or you can use 
separate datasets for each data region . In the current report, you add a new dataset to 
summarize reseller sales by sales territory group and by year . 

	 2.	 Open the Report Data window, click New, and click Dataset . 

	 3.	 In the Dataset Properties dialog box, in the Name box, type 
ResellerSalesByTerritoryByYear . 

		 4.	 In the Dataset Properties dialog box, click Import . 

	 5.	 In the Import Query dialog box, navigate to the Microsoft Press\Rs2008sbs\Chap04 
folder in your Documents folder, double-click ResellerSalesByTerritoryByYear .sql, and 
click OK . 

Add a matrix 
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	 6.	 Open the Toolbox window, and drag the Matrix control onto the design surface to the 
right of the table at the top of the report body, as shown here .

	 7.	 Point to the text box on the second row of the first column, click the Field List icon, 
point to AdventureWorksDW2008, point to ResellerSalesByTerritoryByYear, and click 
SalesTerritoryCountry .

When a dataset is not bound to a data region and multiple datasets exist, the first time 
you make a selection using the Field List, you must select the data source and data 
set before you can select a field . Of course, you can drag a field from the Report Data 
 window and drop it into the text box instead of using the Field List .

Notice that the Grouping pane now shows only the group associated with the matrix . 
The rows and columns you add to a matrix are classified automatically as groups . There 
are no detail rows in a matrix, which is another characteristic differentiating a matrix 
from a table .

	 8.	 Point to the text box on the first row of the second column, click the Field List icon, and 
click CalendarYear .

Notice that CalendarYear appears now as a column group in the Grouping pane . The 
Grouping pane displays only groups associated with the currently selected data region .

	 9.	 In the matrix, point to the text box on the second row of the second column, click the 
Field List icon, and click SalesAmount .

Because there are no detail rows in a matrix, all data field text boxes, appearing at 
the intersections of rows and columns, automatically use the Sum aggregate function, 
 although you can replace it with a different aggregate function .

Notice also that when you click in the data field text box, an orange bar appears to the 
left of the row group and above the column group to show the group scope affecting 
the current text box .



 Chapter 4 Designing Reports 125

	 10.	 Save and then preview the report, as shown here .

The matrix renders to the right of the table . Notice that the years display out of 
 sequence, however . The dataset query for the table includes an ORDER BY clause to 
display the table rows in the desired order without any further change required . If the 
dataset query does not include an ORDER BY clause, or if you want to override the 
ORDER BY clause, you can change the sorting property of the group .

Tip For better performance, you should let the database engine perform sort operations . 
Use report properties only when the database engine can’t perform a required operation, 
such as certain types of calculations that you learn about in Chapter 5 .

	 11.	 Click the Design tab, click the matrix, right-click the CalendarYear group in the 
Grouping pane, and click Group Properties .

	 12.	 In the Group Properties dialog box, in the left pane, click Sorting .

	 13.	 Click Add, and then, in the Sort By drop-down list, select [CalendarYear], as shown here .
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 The default sort order is ascending, which is designated by A to Z in the Order drop-
down list . You can defi ne a sort based on multiple fi elds, each with its own sort order . 
You use the up and down arrow buttons to control the sequence in which the sorts 
 apply . Instead of using dataset fi elds to defi ne a sort, you can click the Expression 
 button to the right of the Sort By drop-down list to use a formula as a sort expression . 
You learn about expressions in Chapter 5 . 

		 14.	 Click OK to close the Group Properties dialog box . 

		 15.	 Click the Preview tab to verify that the sort order is now correct . 

Using a List
 When you use a table or matrix, you present data in text boxes that are arranged in rows or 
columns, but a list can create a more fl exible layout than the other two data regions . You can, 
for example, use nothing but text boxes for a completely free-form layout, or you can use 
a combination of text boxes and other data regions to present some data in free form and 
other data in a structured layout . Unlike the table and matrix data regions, the list supports 
only one level of grouping, but you can implement multiple levels of grouping by nesting 
lists within lists .  

 In this procedure, you create a copy of your report and then use a list to display a text box 
and a matrix in your report . 

Display a text box and a matrix in a list

		 1.	 Click the Design tab, and then click the Save Selected Items button on the toolbar . 

		 2.	 In Solution Explorer, right-click Reseller Sales Summary .rdl, and click Copy . 

		 3.	 In Solution Explorer, click the Reports folder, and press CTRL+V . 

		 4.	 Right-click the new report, Copy Of Reseller Sales Summary .rdl, click Rename, type 
Reseller	Sales	Summary	List.rdl, and press Enter . 

		 5.	 In Solution Explorer, double-click Reseller Sales Summary List .rdl to open the new 
report . 

 Tip After you make a copy of a report, it’s very easy to start making design changes to 
the original report without realizing it . To ensure you’re working on the new report copy, 
you can make sure only the current copy of the report is open by right-clicking the current 
report tab in the document workspace, and clicking Close All But This . 

		 6.	 From the Toolbox window, drag the List control onto the design surface below the 
 matrix, as shown here . 

Display a text box and a matrix in a list
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When you drag a new control onto the design surface near existing controls, you see 
blue snap lines appear to help you align the controls . In this report, you move the list 
later to a new position, so don’t worry right now about getting the alignment perfect .

	 7.	 Right-click anywhere inside the matrix, point to Select, click Tablix2 to select the matrix 
(as indicated by the crosshair), and then, using the crosshair, drag the matrix into the 
list, as shown here .

	 8.	 Right-click anywhere inside the list, point to Select, and click Tablix3 to select the list . 

	 9.	 In the Properties window, in the DatasetName drop-down list, select 
ResellerSalesByTerritoryByYear .

Important The list and any data regions that you nest inside the list, such as the matrix in 
this example, must be bound to the same dataset . 

	 10.	 In the Grouping pane, right-click the Details1 group, and click Group Properties .

The list differs from the table and matrix data regions because you define a group for 
the details row . 

	 11.	 In the Group Properties dialog box, click Add .
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	 12.	 In the Group On drop-down list, select [SalesTerritoryGroup], and click OK .

	 13.	 Right-click the matrix inside the list, point to Select, click Tablix2, and then drag the 
 matrix down inside the list to make room for a text box above the matrix .

	 14.	 From the Toolbox window, drag a text box control into the list above the matrix, and 
position the text box at the left edge of the list just above the matrix, as shown here .

	 15.	 Point to the new text box, click the Field List icon, and click SalesTerritoryGroup .

You can bind data to a freestanding text box, but you must use an aggregate function, 
such as Sum for a numeric field or First for a string field . 

	 16.	 Right-click anywhere inside the list, point to Select, click Tablix3 to select the list, and 
then drag the list to the top edge of the report body just to the right of the table .

	 17.	 Save and then preview the report, as shown here .
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Introducing	the	Tablix
By completing the procedures up to this point in the chapter, you have developed 
experience with the table, matrix, and list data regions . To the report processing en-
gine, these data regions are all treated as a tablix, which is a hybrid data region with 
a fl exible grid layout that can be defi ned with fi xed columns and dynamic rows like a 
table, or dynamic columns and dynamic rows like a matrix . Although you select a table 
control from the Toolbox window, the structure on the report design surface is really 
just a starting point . After starting to design a traditional table layout, if you decide 
you really need to add a column group or defi ne dynamic columns, you can make the 
change easily without the need to discard your work and start development of a matrix 
instead . Similarly, you can add row or column groups to a list to convert it to a table or 
matrix structure . In addition, you can group data more fl exibly . For example, you can 
nest groups in parent and child relationships, but you can also place groups adjacent to 
one another . 

Defi ning Adjacent Groups
 A traditional grouping structure in a table or matrix combines multiple groups into a hierar-
chical structure that refers to a containing group as a parent group and a contained group 
as a child group . A new feature in Reporting Services 2008 is the ability to create an adja-
cent group . One way you might use adjacent groups is to display data in a matrix that uses 
adjacent groups on columns . The data in each adjacent group represents all data from the 
 dataset query . Each adjacent group provides different views of the same data . 

 In this procedure, you update an existing report by adding adjacent groups to a matrix . 

Defi ne adjacent groups

		 1.	 In Solution Explorer, right-click the Reports folder, point to Add, and click Existing Item . 

 You can import a report defi nition fi le into your project instead of creating a report 
from scratch . When you do this, the report defi nition fi le is kept in its original location, 
and a copy of the fi le is added to the project folder . Any edits you make to the report 
affect only the fi le stored in the report server project . 

		 2.	 In the Add Existing Item – Sales dialog box, navigate to the Microsoft Press\Rs2008sbs
\Chap04 folder in your Documents folder, and double-click Reseller Sales By Year By 
Product .rdl . 

		 3.	 In Solution Explorer, double-click Reseller Sales By Year By Product .rdl to open the 
 report in the document workspace . 

Defi ne adjacent groups
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 This report currently contains a matrix similar to the one you created in the “Add a 
Matrix” procedure earlier in this chapter . You are now going to add a second column 
group to the matrix as an adjacent group . 

		 4.	 Right-click the text box containing [CalendarYear], point to Add Group, and select 
Adjacent Right . 

	 5.	 In the Tablix Group dialog box, in the Group By drop-down list, select Category, and 
click OK . 

	 6.	 Point to the text box below [Category], click the Field List icon, and click SalesAmount . 

In this example, you are creating an adjacent group displaying the same value as 
the fi rst group, SalesAmount . However, you could select any fi eld value or use an 
 expression to display an entirely different value in the adjacent group . 

	 7.	 Save and then preview the report . 

	 8.	 To view the entire width of the matrix, as shown here, in the Zoom drop-down list in 
the center of the Preview toolbar, select 75% . 

Adding a Text Box
A text box is a report item that can exist independently of a data region . It can either contain 
static text or an expression that computes a value for the text box at the time of the report 
execution . You use freestanding text boxes for report titles and page numbers, for example .  

In this procedure, you add a static title to your report . 

Add a static report title

	 1.	 Click the Design tab . 

	 2.	 On the Report menu, select Ruler . 

A vertical ruler appears along the left side of the document workspace and a horizontal 
ruler appears across the top of the workspace . You can use these rulers to help align an 
object as you drag it across the design surface . 

	 3.	 Right-click anywhere inside the matrix, point to Select, click Tablix1 to select the matrix, 
and then drag the matrix down on the design surface so that the top edge is approxi-
mately at the ½-inch mark on the vertical ruler . 

Add a static report title
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	 4.	 From the Toolbox window, drag a text box onto the design surface and position it in 
the upper-left corner of the report body . 

		 5.	 Click in the new text box, and type Reseller	Sales	by	Year	and	by	Product . 

	 6.	 Click anywhere in the report outside the text box, click inside the text box to select it, 
and then drag the right edge of the text box to the 3-inch mark on the horizontal ruler . 

	 7.	 Save and then preview the report, as shown here . 

Adding a Line
You can use a line to add visual effects to a report . A line has properties that you can set 
to defi ne its length, width, and color, among other properties . Although you can confi gure 
many property values to change at report execution, as you learn in Chapter 5, a line always 
has a fi xed length that cannot be changed dynamically . 

In this procedure, you add a line below the text box containing the report title . 

Add a line

	 1.	 Click the Design tab . 

	 2.	 In the Toolbox window, double-click the Line control . 

	 3.	 Click the left end of the line and drag it below the report title text box . 

	 4.	 Click the right end of the line and drag the end of the line to stretch the line to the 
same length as the title text box at the same vertical position as the left end of the line . 

When the line length matches the text box width, you see a blue snap line connecting 
the two report items to indicate alignment . The snap line disappears when you release 
your mouse button . Your report layout now looks like this: 

 A line does nothing more than add decoration to a report . Later in this chapter, you 
learn how to use properties to add more visual interest to the line . 

Add a line
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Adding an Image
 You can use an image as a freestanding logo or picture in your report, or you can have 
 pictures associated with rows of data, such as details for a product catalog . You can also use 
an image as a background for a text box, a data region, or the body of a report .  

You can add images to a report in a number of ways . The most straightforward way is to 
 import an image into the report and store it as an embedded image . If you need to refer 
to the same image in many reports, such as a corporate logo, you can store the image on 
a  network share or on a Web server and embed a reference to the image in your report . 
Then, if the image later changes, you can update the image in one location, and all reports 
then use the new image . Finally, for the display of separate images in detail, you can retrieve 
 images from a database . 

In this procedure, you add a logo to your report as an embedded image . 

Add an embedded image

	 1.	 From the Toolbox window, drag the image to the top edge of the design surface at 
 approximately the 4-inch mark of the horizontal ruler . 

	 2.	 In the Image Properties dialog box, in the Name text box, type logo . 

	 3.	 Open the Select The Image Source drop-down list to review the available options: 
External, Embedded, and Database . 

When you select an option, the dialog box changes to prompt you for the information 
required to support the selected option . 

		 4.	 In the Select The Image Source drop-down list, select Embedded . 

If you already have an embedded image in the report, you can select the image in the 
Use This Image drop-down list to use the same image in a new location . Because you 
have no images yet, you must import an image into the report . 

	 5.	 Click Import . 

Add an embedded image
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	 6.	 In the Open dialog box, navigate to the Microsoft Press\Rs2008sbs\Chap04 folder 
in your Documents folder, select BMP Files in the Files Of Type drop-down list, and 
 double-click Logo .bmp . The Image Properties box now looks like this:

	 7.	 In the left pane, click Size, select Original Size, and click OK .

The image height interferes with the expansion of the matrix, but you can resize it to fit 
the page better .

	 8.	 Drag the bottom edge of the image approximately to the ½-inch mark on the vertical 
ruler to position it above the top edge of the matrix, as shown here .

The image resizes proportionally as you manually adjust the height or width .

	 9.	 Save and then preview the report .
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Linking Information with a Subreport
 A subreport is a special report item that serves as a placeholder for another report that you 
want to embed in the report you are currently developing . You can build a report once and 
reuse it many times as a subreport . A popular way to use subreports is to combine many 
online reports into a single report for the purpose of producing a PDF document . You can 
pass parameter values from the report to the subreport to change the subreport’s content 
dynamically, which you learn about in Chapter 6 . 

 Note The page header and page footer sections of the subreport do not render in the parent 
report . 

 In this procedure, you add a subreport to your report . 

Add a subreport

		 1.	 Click the Design tab . 

 First, to preview your report and subreport by using Report Designer, you should add 
the other report to your report server project if it’s not already there . The subreport is 
not required to be stored in the same location as the parent report once deployed, but 
you need to provide the path to the report when you confi gure the subreport . 

		 2.	 In Solution Explorer, right-click the Reports folder, point to Add, and click Existing Item . 

		 3.	 In the Add Existing Item – Sales dialog box, navigate to the Microsoft Press\Rs2008sbs
\Chap04 folder in your Documents folder, and double-click Reseller Sales By Business 
Type .rdl . 

		 4.	 In the Reseller Sales By Year By Product report, from the Toolbox window, drag 
Subreport to the design surface below the matrix . 

 A placeholder appears for the subreport . By default, this placeholder is three inches 
high and three inches wide, but you see when you preview the report that the 
 subreport is not confi ned to these dimensions . You can resize the placeholder if 
you prefer . 

		 5.	 Right-click the subreport, and select Subreport Properties . 

		 6.	 In the Subreport Properties dialog box, in the Use This Report As A Subreport drop-
down list, select Reseller Sales By Business Type, and click OK . 

 The name of the report displays inside the subreport placeholder to help you identify 
the report that will display in that location . 

Add a subreport
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	 7.	 Save, and then preview the report, as shown here . 

enhancing	the	Report	Appearance
After you fi nalize the data layout, you can then improve your report by confi guring proper-
ties to manage the location and size of report items, change the formatting of report items, 
or control the paging of the report . For large reports, you might add page breaks to separate 
the report into logical groupings . If your report contains multiple pages, you might add page 
headers and page footers to repeat information on each page such as the report title and 
page number . 

Confi guring the Placement and Size of a Report Item
You can use drag-and-drop to move a report item or a data region to a new location, 
and you can drag the edges of a report item to make it larger or smaller . However,  using 
drag-and-drop to perform these tasks might not provide the precision you need for a 
pixel- perfect report . Instead, you can use the Location and Size properties to confi gure the 
placement and size of a report item to meet exact specifi cations . 

In this procedure, you reposition and resize the logo image . 

Change the value of the Location and Size properties

		 1.	 Click the Design tab, and then, on the design surface, click the image . Alternatively, in 
the Properties window, select Logo . 

Change the value of the Location and Size properties
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		 2.	 In the Properties window, scroll down to locate the Location and Size boxes in the 
Position category . 

 By default, properties are arranged by category . If you prefer, you can switch to an 
alphabetical arrangement by clicking the Alphabetical button on the Properties toolbar .  

	 3.	 To the left of the Location box, click the plus sign (+) to expand the property . 

There are actually two values you must provide for the Location property: Left and Top . 
These values provide the coordinate for the upper-left corner of the selected report item . 

	 4.	 In the Left box, type 3in, and in the Top box, type 0in if it contains a different value . 

	 5.	 To the left of the Size box, click the plus sign (+) to expand the property . 

	 6.	 In the Width box, type 1.5in, and in the Height box, type 0.5in . 

	 7.	 Review the report design surface to see the new placement and size of the image . 

Changing the Appearance of a Report Item
Many properties are available for confi guring the appearance of a report item . Most com-
monly, you defi ne format strings, font sizes, styles, and colors of text, but you can also use 
properties related to borders, padding, and background colors, among others . A new feature 
in Reporting Services 2008 allows you to set different formatting properties for selected text 
within a text box .  

In this procedure, you use the Properties window to set report item properties . 

Set report item properties

	 1.	 Click inside the text box containing the report title and highlight the text . 

Notice that the current report item in the Properties window is Selected Text . Rather 
than applying format properties to all the text in a text box (which was the only option 

Set report item properties
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in previous versions of Reporting Services), you can apply properties to selected text 
within a text box .

	 2.	 On the toolbar above the document workspace, click the Bold button .

Note The Bold button, along with other buttons that define format properties, appears 
on the Report Formatting toolbar that displays by default in BI Dev Studio . If you don’t see 
this toolbar, right-click any visible toolbar and select Report Formatting .

You can set a variety of properties for selected text, including Indent, SpaceAfter, 
SpaceBefore, TextAlign, Color, Font, or LineHeight . You can also define bulleted and 
numbered lists and list indention .

	 3.	 In the text box, select Reseller Sales, and then, in the Font Size drop-down list on the 
Report Formatting toolbar, select 12pt .

	 4.	 With Reseller Sales selected, in the Properties window, in the Color box, select Blue .

	 5.	 Click the tablix, and then click the row handle of the first row to select the entire row .

You can apply formatting to all text boxes in a row or column by selecting the 
 applicable handle in the data region .

	 6.	 On the Report Formatting toolbar, click the Bold button .

	 7.	 In the Properties window, in the BackgroundColor drop-down list, select Light Gray .

	 8.	 In the tablix, click the text box containing [Category], and then, on the Report 
Formatting toolbar, click the Align Right button .

	 9.	 In the tablix, click the text box in the second column containing [Sum(SalesAmount)], 
and then, while holding the Shift key, click the text box to its right .

	 10.	 In the Properties window, in the Format box, type C0 .

Tip Recall from Chapter 3 that you can use any Microsoft Visual Basic  .NET format string 
for this property .

	 11.	 Click the line below the report title, and then, in the Properties window, in the 
LineColor drop-down list, select Blue .

	 12.	 In the LineWidth box, type 5pt . 

	 13.	 In the Location/Left box, type 0in,	and in the Location/Top box, type 0.4in .

	 14.	 In the Properties window, in the report item drop-down list, select Textbox3, and then, 
in the Location/Left box, type 0in,	and in the Location/Top box, type 0in .
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		 15.	 Click Save Selected Items, click the Preview tab, and in the Zoom drop-down list, select 
100% to better view the report, as shown here . 

Setting Page Breaks
By default, the report processing engine will fi t as much of a data region onto a page as it 
can before creating a page break . You can override this behavior by inserting page breaks 
relative to a data region, or when a group instance changes within a data region . 

In this procedure, you add page breaks to your report . 

Add page breaks

	 1.	 Click the Design tab . 

	 2.	 In the Properties window, in the report item drop-down list, select Tablix1 . 

	 3.	 In the PageBreak drop-down list, select End . 

When the report renders the tablix, a page break forces the subreport to start on the 
next page . The PageBreak property allows you to set a page break before the data 
 region renders, after the data region renders, or both before and after rendering . 

	 4.	 In Solution Explorer, double-click Reseller Sales By Business Type .rdl to open the report 
for editing . 

	 5.	 In the Grouping pane, right-click the SalesTerritoryGroup, and click Group Properties . 

	 6.	 In the Group Properties dialog box, click Page Breaks, select the Between Each Instance 
Of A Group check box, and click OK . 

	 7.	 Save and then preview the report . 

Add page breaks
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The first page of the report now contains only the tablix displaying sales by sales 
 territory on rows and by business type on columns . The first group instance, Europe, 
displays .

Note The question mark that appears to the right of the page number indicates that 
the report is not yet fully rendered and the total number of pages in the report is not yet 
available . When a report renders one page at a time, you experience better performance, 
especially when a report contains a lot of data .

	 8.	 On the Preview toolbar, click the Next Page button .

On the second page of the report, you see the North America group instance . Each 
group instance appears on a separate page . Notice, however, that the column labels are 
missing . You can configure the data region to repeat column labels on each page .

	 9.	 Click the Design tab .

	 10.	 In the Grouping pane, click the arrow that appears to the right of the Column Groups 
label, and click Advanced Mode to display all groups, as shown here .

	 11.	 In the Row Groups section, click the first Static group, and then, in the Properties 
 window, in the RepeatOnNewPage drop-down list, select True .

	 12.	 Save the report .

Adjusting the Report Size for Print-Ready Formats
Your report has properties, too . You might need to set page size and margin properties for 
reports that will be printed or exported to PDF format . You can also define background color 
or image properties, or add borders to your report . There is also a property to eliminate 
white space so that blank pages are not added to your report .
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 In this procedure, you change the PageSize property to change the report to a landscape 
format . 

Use the PageSize property to defi ne a landscape format

		 1.	 In Solution Explorer, double-click Reseller Sales By Year By Product .rdl . 

	 2.	 In the Properties window, in the report item drop-down list, select Report . 

	 3.	 Expand the PageSize box, type 11in	in the Width box, and type 8.5in	in the Height 
box . 

The PageSize property applies only to a report rendered to a print-ready format such 
as PDF or TIFF . To adjust sizing of a report for online viewing, you use the InteractiveSize 
property . 

Because the fi rst tablix in the report is very wide, you must make some additional ad-
justments to fi t the data region onto a single page even though you have defi ned a 
landscape format by setting a page size of 11 inches by 8 .5 inches . Changing margin 
size is one type of adjustment you can make . 

	 4.	 Expand the Margins text box, type 0.25in	in the Left box, and type 0.25in	in the Right 
box . 

Even after making adjustments to margins and page size, a data region still might not 
fi t on a page . In this case, you can adjust the font size and column spacing to reduce 
the overall space required by the data region . 

		 5.	 Click anywhere in the fi rst tablix, click the fi rst column handle, and then, while pressing 
the CTRL key, click the second and third column handles . 

		 6.	 On the Report Formatting toolbar, in the Font Size drop-down list, select 8pt . 

		 7.	 Click the second column handle, and then, in the Properties window, expand the Size 
text box and type 1in	in the Width box .  

		 8.	 Preview the report, click the Print Layout button on the Preview toolbar, and click the 
Next Page button on the Preview toolbar . 

 Although you have adjusted the report to fi t the fi rst tablix on a single page, the 
 second page of the report is blank, which indicates that the body and margins of the 
report are too wide for the report page size .  

		 9.	 Click the Design tab, and notice the amount of white space to the right of Tablix1 .  

 The white space in the body of your report is preserved by default, which can extend 
the body size beyond the width of the report and cause blank pages to appear . You can 
disable this behavior by setting the ConsumeWhiteSpace property of the report . 

		 10.	 In the Properties window, in the report item drop-down list, select Report, and then, in 
the ConsumeContainerWhitespace drop-down list, select True . 

Use the PageSize property to defi ne a landscape format



 Chapter 4 Designing Reports 141

	 11.	 Preview the report, click the Print Layout button on the Preview toolbar, and click the 
Next Page button on the Preview toolbar . 

The second page of the report now displays the fi rst page of the subreport .  

	 12.	 Continue paging through the report to observe the page break between group 
 instances and the repeating column labels for each group instance . 

Adding a Page Header and Page Footer
The page header and page footer sections of a report are optional and disabled by default . 
If you want to repeat information or images on all report pages, you can enable these report 
sections and then place a text box or image inside the desired section . You cannot add a 
dataset fi eld to a text box in a page header or page footer, nor can you add a data region or 
subreport in these sections . 

In this procedure, you add a report title to the page header that displays on all but the fi rst 
page, and add page numbers to the page footer that display on all pages of the report . 

Add a page header and a page footer

	 1.	 Click the Design tab . 

	 2.	 On the Report menu, select Add Page Header . 

	 3.	 In the Report Data window, expand the Built-in Fields folder, and drag Report Name to 
the page header, aligning the left edge of the text box with the left side of the report . 

	 4.	 Drag the right edge of the text box to the same width as the report title text box in the 
body of the report . 

You can prevent the display of the text box in the page header on the fi rst page only 
by changing the PrintOnFirstPage property . By default, the report items in the page 
header display on each page of the report . 

 Important If you later decide to remove the page header, all report items contained in 
the page header will be deleted from the report . 

	 5.	 Click anywhere in the page header to set it as the current report item in the Properties 
window, and then, in the PrintOnFirstPage drop-down list, select False . 

	 6.	 Right-click in the area below the report body in the document workspace and click Add 
Page Footer . 

	 7.	 From the Report Data window, drag Page Number to the left side of the page footer . 

Add a page header and a page footer
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 Because the page number is a numeric value, the page number aligns right when the 
report renders . If you position the page number on the left side of the page footer, you 
can change the text box to align left . 

	 8.	 With the text box containing [PageNumber] selected, click the Align Left button on the 
Report Formatting toolbar . 

	 9.	 Save and then preview the report . Page through the report to test the appearance of 
the page header and page footer . 

	 10.	 On the File menu, select Close Project, and, if the Microsoft Visual Studio message box 
appears, click Yes to save the solution . 

You’ve learned a lot about developing reports in this chapter, but there is still much more to 
learn . In the next chapter, you learn how to work with expressions to use calculations in your 
report and to change the content and appearance of your report dynamically . 

Chapter	4	Quick	Reference

 To Do This

 Create a new report server project Open Business Intelligence Development Studio; on the File 
menu, select New, Project, select Report Server Project in 
the Template list, and provide a name and location for the 
project .

 Add a new report to your report 
server project

In Solution Explorer, right-click the Reports folder, select 
Add, click New Item, select Report in the Templates list, and 
provide a name for the report .

 Create a shared data source In the Report Data window, click New, click Data Source, 
provide a report data source name, click New, provide a 
shared data source name, select a provider type, specify 
a connection string, click Credentials, and select a report 
 authentication method .

 Create a dataset In the Report Data window, click New, click Dataset, provide 
a dataset name, select a data source, and provide a query 
string . 

 Add a data region to the report 
lay out

In the Toolbox, double-click a table, matrix, or list control; 

or 

Drag a control from the Toolbox onto the Report Designer 
design surface .

 Bind data to a data region From the Report Data window, drag a fi eld from a dataset 
into a text box in a data region; 

or 

Point to a text box in a data region, click the Field List icon, 
and click a dataset fi eld .

To Do This
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 To Do This

 Preview a report Click the Preview tab .

 Group data Right-click a text box in a data region, select Add Group, 
and then, in the Row Group or Column Group section, select 
one of the following options: Parent Group, Child Group, 
Adjacent Above, Adjacent Below, Adjacent Left, or Adjacent 
Right . In the Tablix Group dialog box, select a fi eld in the 
Group By drop-down list, and add a group header or group 
footer if you want .

 Add a total Right-click a text box containing a value to total, and click 
Add Total .

 Sort group instances In the Grouping pane, right-click a group, select Group 
Properties, Sorting, Add, and then, in the Sort By drop-down 
list, select a fi eld . In the Sort By drop-down list, select a sort 
direction .

 Add a static report title From the Toolbox window, add a text box to the design 
surface . Click in the new text box, and type a string for the 
report title .

 Add a line From the Toolbox window, add a line to the design surface, 
drag the line endpoints to the desired position, and set 
 applicable properties, such as LineColor or LineWidth, in the 
Properties window . 

 Add an embedded image From the Toolbox window, add an image to the design 
 surface . In the Image Properties dialog box, provide a name 
for the image, select Embedded in the Select The Image 
Source drop-down list, click Import, navigate to the image 
location, and double-click the image fi le .

 Add a subreport From the Toolbox window, add a subreport to the  design 
surface . Right-click the subreport, select Subreport 
Properties, and select a report in the Use This Report As A 
Subreport drop-down list . 

 Change the placement and size of a 
report item

On the design surface, select the report item, and then, in 
the Properties window, change the values of the Location/
Top and Location/Left boxes for placement and the Size 
Height and Size Width boxes for size of the report item .

 Change the appearance of text in a 
text box

Click inside the text box, highlight all or part of the text 
within the text box, and use the buttons on the Report 
Formatting toolbar, such as Bold, or change values of 
 properties, such as Color, in the Properties window .

 Resize a report In the Properties window, in the report item drop-down list, 
select Report, expand the PageSize box, and change the 
values of Width and Height .

To Do This
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 To Do This

 Set page breaks In the Properties window, in the report item drop-down 
list, select a tablix item, and select a value in the PageBreak 
drop-down list to control a page break relative to a report 
item;

or

In the Grouping pane, right-click a group, select Group 
Properties, Page Breaks, Between Each Instance Of A Group, 
and (if you want) Also At The Start Of A Group or Also At 
The End Of A Group .

Eliminate blank pages In the Properties window, in the report item drop-down 
list, select Report, and select True in the ConsumeContainer-
Whitespace drop-down list .

Add a page header or page footer On the Report menu, click Add Page Header or Add Page 
Footer .

To Do This
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Chapter 10

Deploying Reports to a Server
After completing this chapter, you will be able to:

n Deploy reports to the report server .

n Organize content on the report server by using folders .

n Create a linked report on a native-mode report server .

n Override report parameter settings .

n Manage authentication in data sources .

n Control report execution .

n Create and store report snapshots in history .

The process of deploying reports includes a variety of tasks that are covered in this chapter . 
At minimum, you place report definition files on the report server to make reports available 
to users . Typically, you also configure data sources to associate reports with a different test 
or production database . You might create alternate versions of a base report by setting up 
linked reports or generating report copies . You can also configure report properties, such as 
report parameter default values, execution options, or history management properties, to 
control what data displays in a report, the amount of time before the user request that the 
data is retrieved for the report, and the amount of time a snapshot of a report is saved on 
the report server .

Important To complete the procedures in this chapter, you must be assigned to the Content 
Manager role on a native-mode report server or to the Owners role on an integrated-mode 
report server . If you are a local administrator on the server, you have the correct role assignment 
by default .

You learn more about assigning security permissions to control user activity on the report 
server in Chapter 11, “Securing Report Server Content .”

Reviewing	Deployment	Options
The deployment process copies the report definition into the ReportServer database 
described in Chapter 1,”Introducing Reporting Services .” A shared data source or a file that 
you want to store centrally for user access can also be deployed to the report server and is 
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similarly stored in the ReportServer database . Report developers typically deploy a report 
directly from Business Intelligence Development Studio (BI Dev Studio), while report server 
administrators often deploy a report manually by using Report Manager or programmatically by 
using the Rs utility (described more fully in Chapter 16, “Programming Reporting Services”) . 

Deploying a Report Project
A solution in BI Dev Studio can contain one or more report projects, each of which can 
contain one or more reports . Each project has a set of properties to defi ne the target location 
for the reports and data sources that it contains . After you defi ne these properties, you can 
deploy all reports in all report projects in the solution, all reports in a single report project, a 
selected set of reports, or a specifi c report . 

In this procedure, you use BI Dev Studio to deploy a report server project . 

Deploy a report project to a report server

	 1.	 Click Start, select Microsoft SQL Server 2008, and then select SQL Server Business 
Intelligence Development Studio . 

	 2.	 On the File menu, select Open, and then select Project/Solution . 

	 3.	 In the Open Project dialog box, navigate to the Microsoft Press\Rs2008sbs\Chap10 
folder in your documents folder, select Sales .sln, and click Open . 

Important Although the reports in this project are similar to the reports that you created 
if you completed the previous chapters, you must use the report project in the Chap10 
folder to complete all procedures in this chapter successfully . 

	 4.	 In Solution Explorer, right-click Sales, and then select Properties . 

Note Many of the remaining steps to follow in this procedure depend on whether your 
target report server is native mode or SharePoint integrated mode . Each step includes 
instructions for both architectures . 

	 5.	 In the Sales Property Pages dialog box, in the TargetDataSourceFolder text box, pro-
vide the target location for the shared data source in the project . You can create a 
hierarchy of folders also by including each folder name in the TargetDataSourceFolder 
box and separating each folder name with a forward slash (/) . 

q Native mode: Keep the default value, Data Sources. This folder will be created on 
the Home page of Report Manager if it doesn’t already exist . 

Deploy a report project to a report server
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q Integrated mode: Type http://<servername>/sites/ssrs/data	connections, 
replacing <servername> with the name of your server .

Note This URL for the integrated mode server assumes that you followed the instructions 
in Chapter 2, “Installing Reporting Services,” to create a Report Center site called SSRS . 
Replace the example URL if you have an alternate site available .

Important Even if you are deploying to your local computer, you must specify the server 
name in the URL rather than localhost . Otherwise, the deployment fails with the following 
error: Report Server has encountered a SharePoint error .

In a typical SharePoint integrated-mode configuration, you store data sources in a data 
connections library, but you can use any document library to which the report data 
source content type has been added .

	 6.	 In the TargetReportFolder text box, provide the target location for the reports in the 
project .

q Native mode: Keep the default value, Sales.

q Integrated mode: Type http://<servername>/sites/ssrs/ReportsLibrary,	replacing 
<servername> with the name of your server .

The target report folder can be any document library to which the report content type 
has been added as described in Chapter 2 .

	 7.	 In the TargetServerURL text box, provide the URL for the target report server .

q Native mode: Type http://localhost/ReportServer, as shown here, and then 
click OK .

Note This procedure assumes that you followed the instructions in Chapter 2 to in-
stall Reporting Services on your local computer and to create a virtual directory called 
ReportServer for the Web service . Replace the server name or the virtual directory name 
in this URL as appropriate if your configuration differs from the environment described in 
Chapter 2 .
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q Integrated mode: Type http://<servername>/sites/ssrs, replacing <servername> 
with the name of your server, as shown here .

Note In this example, and throughout this chapter, the server name in the URL is fictitious 
and is included for illustration purposes only .

Notice that the target server URL does not include a reference to the report server 
virtual directory as it does when deploying to a native-mode report server . In this case, 
you deploy to a SharePoint site that is configured for Reporting Services as described 
in Chapter 2 .

	 8.	 In Solution Explorer, right-click Sales, and select Deploy .
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Tip In this procedure, you deploy all reports in the project . In some cases, you might 
prefer to deploy a specific report or set of reports . To limit deployment to a set of one or 
more reports, select each report to include in the set, right-click one of the reports in the 
set, and then select the Deploy command from the shortcut menu .

	 9.	 Review the output of the deployment process in the Output window, which displays at 
the bottom of your screen in the default layout . The Output window shown here is for 
deployment to a native-mode report server . An integrated-mode report server deploy-
ment looks very similar and displays the report’s URL reference as each report deploys .

	 10.	 When deployment completes, open Windows Internet Explorer and navigate to the 
Web application hosting Reporting Services .

q Native mode: In the address bar, type http://localhost/Reports	to open the 
Home page in Report Manager, and then click the Sales link to view the deployed 
reports, as shown here .

q Integrated mode: In the address bar, type http://<servername>/sites/ssrs	
/ReportsLibrary	to open the Reports Library, replacing <servername> with the 
name of your server, as shown here .



304 Part III Managing the Report Server

Note The SampleWorkbook appearing in the Reports Library is a Microsoft Office Excel 
2007 workbook added to the Reports Library automatically when you created the site 
 collection . The Reseller Sales item is the report model that is deployed at the end of 
Chapter 9, “Developing Report Models .”

All files are physically stored as binary files in the Catalog table in the ReportServer 
 database . For a native-mode report server, Report Manager queries this table to 
 retrieve a list of the items for the current folder, Sales, and displays the results in two 
columns in alphabetical order . An integrated-mode report server also stores the report 
definition files in the SharePoint content database and displays the list of report defini-
tion files as a single column of report titles .

Uploading a Report
In some organizations, certain users might have permission to add content to the report 
server but might not be report developers and therefore won’t have BI Dev Studio installed 
on their computers . These users can upload reports directly to the report server using the 
Web application interface .

In this procedure, you upload a report to the report server .
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Upload a report to a report server

	 1.	 In Internet Explorer, open the target report folder . 

q Native mode: If the Sales folder is not already open, in the address bar, type 
http://localhost/Reports/Sales . 

q  Integrated mode: If the reports library is not already open, type 
http://<servername>/sites/ssrs/ReportsLibrary, replacing <servername> with 
the name of your server . 

		 2.	 Upload the Sales Summary report defi nition fi le . 

q  Native mode: On the Report Manager toolbar, click Upload File, click Browse, 
navigate to the Microsoft Press\Rs2008sbs\Chap10 folder in your documents 
folder, select Sales Summary .rdl, and click Open . In the Name text box, keep 
the default report name, as shown here, and click OK . 

q  Integrated mode: On the SharePoint toolbar, click the Upload button, click Browse, 
navigate to the Microsoft Press\Rs2008sbs\Chap10 folder in your documents folder, 
select Sales Summary .rdl, and click Open . On the Upload Document: Reports 
Library page, shown here, click OK . 

 Note By default, the uploaded document in SharePoint adds the report defi nition as new 
content to support the versioning feature in SharePoint . In-depth coverage of generic 
features of SharePoint such as this is beyond the scope of this book . However, you can 
learn more from the Help article “Introduction to Versioning,” at http://offi ce.microsoft.com
/en-us/help/HA100215761033.aspx?pid=CL100605171033 . 

Upload a report to a report server
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	 3.	 On a SharePoint integrated-mode report server, keep the default report name, as 
shown here, and then click OK .

Important The upload process to a report server in native mode or integrated mode 
does not associate the report definition file with a data source, which prevents you from 
viewing the report at this time . Later in this chapter, you learn how to correctly associate a 
report with its data source .

Using the Rs Utility
A report administrator can use script files to manage many activities on a native-mode report 
server, including report deployment . When you want an administrator to deploy reports in 
bulk, you develop a script file using Microsoft Visual Basic  .NET and save the file as a Unicode 
or UTF-8 text with an  .rss file name extension . Then you provide the administrator with the 
script file and report definition files to be uploaded . The report administrator can then use 
the script file as an input file for the Rs utility (described in more detail in Chapter 16) .
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Important The Rs utility is not supported for use with an integrated-mode report server . 

In this procedure, you execute the Rs utility with the DeploySalesReports .rss script to deploy 
reports . 

Deploy reports to a native-mode report server by using the Rs utility

	 1.	 On a native-mode report server, open a command prompt window . 

	 2.	 Type the command to navigate to the folder containing the script fi le . For example, 
if you’re running Windows XP or Windows Server 2003, type cd	C:\Documents	and	
Settings\<username>\My	Documents\Microsoft	Press\Rs2008sbs\Chap10 . 
If you’re running Windows Vista or Windows Server 2008, type cd	C:\Users
\<username>\Documents\Rs2008sbs\Chap10 . 

	 3.	 To run the Rs utility, type rs	–i	DeploySalesReports.rss	–s	http://localhost
/ReportServer, and press Enter . The results of executing the utility display in the 
 command prompt window . 

	 4.	 To confi rm the successful deployment of the reports, switch to Internet Explorer, navi-
gate to http://localhost/Reports, and click the Sales And Order Quantity Analysis link in 
Report Manager and view the list of reports . 

Managing	Content
One way to manage content on a report server is to store every report in a single location, 
such as the Home page, but before long, you’ll fi nd that the number of reports becomes so 
large that it is diffi cult to manage security and to fi nd content . You can use folders to simplify 
report management and usage . You can move content to a new folder later and, on a native-
mode server, use a linked report to set up variations of a single report for applying different 
properties such as security or parameters . 

Using Folders to Organize Content
Folders are useful for organizing content into logical groups by subject matter, target audi-
ence, security, or any combination of these . Folders can be nested into a hierarchical struc-
ture, and you can provide a description for a folder to provide users with more information 
about the folder contents . On a native-mode report server, you can also hide a folder name 
from the list view in Report Manager . 

In this procedure, you add folders to store reports . 

Deploy reports to a native-mode report server by using the Rs utility
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Add a folder to a report server

		 1.	 In Internet Explorer, open the home folder for Reporting Services . 

q Native mode: In the address bar, type http://localhost/Reports	to open the 
Home folder in Report Manager or click the Home link at the top of the window . 

q Integrated mode: Type http://<servername>/sites/ssrs/ReportsLibrary, replacing 
<servername> with the name of your server, to open the Reports Library folder in 
SharePoint . 

	 2.	 Add a new folder . 

q Native mode: On the Report Manager toolbar, click the New Folder button . 

q Integrated mode: On the Reports Library toolbar, click the arrow on the New but-
ton, and select Folder . 

	 3.	 Provide a name for the folder . 

q Native mode: Replace the default name with For	Review, and then, in the 
Description box, type Reports	in	this	folder	are	pending	user	review	and	
acceptance, as shown here . Click OK . 

Note On a native-mode report server, you can hide a folder in the list view . Hiding a 
folder is not a security measure because the user can switch to detail view and see the 
folder . However, you can use a hidden folder to store reports that users don’t normally 
access . For example, you can use a hidden folder to store subreports that users don’t need 
to view as individual reports . 

q Integrated mode: In the Name text box, type For	Review, and click OK . 

Add a folder to a report server
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Moving Content
Getting the right folder structure established for reports might take some time . After reports 
are deployed to a report server, you can move them from one folder to another folder . 

In this procedure, you move selected reports from the Sales folder to the For Review folder . 

Move content

	 1.	 In Internet Explorer, open the folder containing the Reporting Services reports that you 
deployed earlier in this chapter . 

q Native mode: On the Home page of Report Manager, click the Sales link . 

q Integrated mode: If the Reports Library folder is not already open, in the 
address bar, type http://<servername>/sites/ssrs/ReportsLibrary, replacing 
<servername> with the name of your server . 

	 2.	 Open the view that allows you to select the reports to move . 

q Native mode: On the Report Manager toolbar, click the Show Details button . 

When you click the Show Details button, the contents of the folder display as a single 
list with a check box to the left of each item, as shown here . You can move or delete 
one or more items in the list by selecting each item’s check box and then clicking the 
Move or Delete button on the toolbar, respectively . 

q Integrated mode: In the upper-right corner of the window, click Site Actions, se-
lect Manage Content And Structure, and then, in the tree view on the left, select 
Reports Library to view the library contents, as shown here . 

Move content
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	 3.	 Select all reports except the Reseller Sales Margin Analysis by Sales Territory report to 
move to the For Review folder .

q Native mode: Select the uppermost check box (to the left of Edit) to select all 
 reports, clear the Reseller Sales Margin Analysis By Sales Territory check box, and 
then click Move .

q Integrated mode: Select the uppermost check box (to the left of Type) to select 
all reports, clear the For Review, SampleWorkbook .xlsx, Sample Dashboard .aspx, 
Reseller Sales .smdl, and Reseller Sales Margin Analysis By Sales Territory check 
boxes, click the arrow on the Actions button, and select Move .

	 4.	 Select the For Review folder as the target location for the reports .

q Native mode: Select the For Review folder, as shown here, and then click OK .

q Integrated mode: In the Move… Webpage Dialog box, expand Reports Library, 
select the For Review folder, as shown here, and then click OK .



 Chapter 10 Deploying Reports to a Server 311

	 5.	 Open the For Review folder to confirm that the seven reports have been moved 
successfully .

q Native mode: In the upper-left corner of the browser window, click the Home link, 
and then, in the list view, click the For Review link .

q Integrated mode: In the address bar, type	http://<servername>/sites/ssrs	
/ReportsLibrary/For	Review, replacing <servername> with the name of your 
server .

Important When you move reports to a new folder on an integrated-mode report server, 
the link between the data source and the report breaks . You must reset the link on each 
report manually before users can view the reports . In the sections “Configuring Report 
Parameters,” “Executing a Report on Demand,” and “Saving Report Snapshots in History,” 
later in this chapter, you perform the steps necessary to reset this link for three reports .

Creating a Linked Report
On a native-mode report server, you can create a variation of a report without the need to 
create and maintain multiple report definition files by creating a linked report . A linked report 
is a separate report item on the report server that uses a report definition file as a base but 
has separate execution, parameter, subscription, and security properties . A common reason 
to use a linked report is if you want to build a report that contains data for multiple departments 
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and includes a parameter to fi lter the report content by department . You can then deploy 
the report to a folder that none of the users can access, create one linked report per depart-
ment, set the report parameter default to a specifi c department, and confi gure security such 
that users can access only the linked report for their department . 

In this procedure, you create a linked report for the Reseller Sales Margin Analysis by Sales 
Territory report . 

Create a linked report

	 1.	 In Internet Explorer, click the Home link at the top of the window, and then click the 
Sales link . 

Note If you see the Hide Details button, then the list view is visible in Report Manager . 
You must be in list view to access the Properties page of a report directly, without view-
ing the report fi rst . If Report Manager is not in list view, perform step 2 to switch modes . 
Otherwise, you can skip to step 3 . 

	 2.	 If necessary, click the Show Details button to switch the view to list view . 

	 3.	 In the Edit column for the Reseller Sales Margin Analysis by Sales Territory report, click 
the Properties icon, as shown here . 

Properties Icon

	 4.	 Click Create Linked Report . 

	 5.	 In the Name text box, type Pacifi	c	Reseller	Sales	Margin	Analysis, as shown here . 

Note that, as with the base report, you can add a description to the linked report . By 
default, the linked report is created in the same folder as the base report . You can click 
Change Location and select a target folder for the linked report . 

	 6.	 Click OK . 

The linked report displays in the browser window . You can now change the properties of 
the linked report . For example, to display only data for the Pacifi c sales territory in the 
report, you must change the parameter properties, which you do in the next procedure . 

Create a linked report



 Chapter 10 Deploying Reports to a Server 313

Copying a Report
Although you cannot create linked reports on an integrated-mode report server, you can 
create a copy of a report to achieve a similar result . That is, you can reproduce the same 
report defi nition as a separate fi le on the report server and set different execution, parameter, 
subscription, and security properties on the new fi le . However, any changes to the base 
report defi nition do not update the copy . 

Important If you followed the steps in Chapter 2, you currently have a site collection at 
http://<servername>/sites/ssrs . To complete the following procedure successfully, you must 
also have a root site collection, http://localhost, on your SharePoint server . To create a root 
site collection, click Start, select All Programs, Administrative Tools, and SharePoint 3 .0 Central 
Administration . Click the Application Management tab, and click the Create Site Collection link . In 
the Web Application drop-down list, select Change Web Application, and then select SharePoint 
– 80 in the list associated with the root URL, http://<servername> . On the Create Site Collection 
page, provide a title for the site, and then, in the Web Site Address section, make sure the URL 
looks like this: http://<servername>/, selecting / in the drop-down list to replace sites if neces-
sary . Select a template of any type for the site . In the Primary Site Collection Administrator sec-
tion, in the User Name box, type your login name, and click the Check Names icon to the right . 
Click OK to create the root site collection . 

In this procedure, you create a copy of the Reseller Sales Margin Analysis by Sales Territory 
report on an integrated-mode server . 

Create a report copy

	 1.	 In Internet Explorer, in the navigation bar on the left, click Reports . 

	 2.	 Point to the Reseller Sales Margin Analysis by Sales Territory report, click the Edit 
button (which appears as an arrow to the right of the report title), point to Send To, 
and select Other Location . 

	 3.	 On the Copy: Reseller Sales Margin Analysis By Sales Territory .rdl page, in the 
Destination Document Library Or Folder box, append /ReportsLibrary	to the existing 
URL . 

	 4.	 In the File Name For The Copy box, replace the default text by typing Pacifi	c	Reseller	
Sales	Margin	Analysis, as shown here . 

Create a report copy
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Note Because the Reporting Services deployment process does not depend on check-
ing items in and out, setting the Prompt The Author To Send Out Updates When The 
Document Is Checked In? option to Yes does not lead to an update of the report copy 
when the base report changes . 

	 5.	 Click OK . 

	 6.	 In the Copy Progress message box, click OK, and then, when the copy operation 
completes, click Done . 

	 7.	 In the Copy Progress message box, click OK . 

 The report copy displays in the list of reports . You can now change properties for the 
report copy, which you do in the next procedure . 

Confi guring Report Parameters
Besides managing the location of reports on the report server, you can also manage the 
default values that are confi gured for the report parameters . In addition, you can remove 
the parameter prompt for a report so that a user cannot choose a different parameter value . 

In this procedure, you confi gure the default value of a parameter in the Pacifi c Reseller Sales 
Margin Analysis report and remove the user prompt for the parameter . 

Confi gure parameter properties

	 1.	 In Internet Explorer, open the parameter properties page of the Pacifi c Reseller Sales 
Margin Analysis report that you created earlier in this chapter . 

q Native mode: Open the report if necessary, click the Properties tab above the 
report, and then click the Parameters link . 

Confi gure parameter properties
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q Integrated mode: Open the reports library folder for the report, if necessary, point 
to the report in the list, click the Edit button (which appears to the right of the 
report title), and select Manage Parameters .

	 2.	 Change the default value for the SalesTerritoryGroup parameter to Pacific.

q Native mode: On the SalesTerritoryGroup row, in the Default Value drop-down 
list, clear the rows containing Europe and North America, as shown here .

q Integrated mode: Click the SalesTerritoryGroup link, and then, in the Use This 
Value drop-down list, clear the check boxes for the rows containing Europe and 
North America .

	 3.	 Remove the user prompt for SalesTerritoryGroup .

Important When a default value is missing for a report parameter, the report cannot 
execute until the user provides a parameter value . For this reason, be sure not to remove 
the user prompt for a report parameter without also specifying a default value, or else the 
report can never execute .

q Native mode: On the SalesTerritoryGroup row, clear the Prompt User check box, 
and then click Apply .

q Integrated mode: Select the Hidden option, click OK, and then, on the Manage 
Parameters: Pacific Reseller Sales Margin Analysis page, click Close .

Note The Hidden option allows you to specify a default value for a report parameter 
without allowing the user to view or change the report parameter value . The Internal 
option also hides the parameters, but it requires an expression in the report definition 
to evaluate at run time .

	 4.	 View the report .

q Native mode: Above the parameter properties, click the View tab to render the 
report, as shown here .
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Notice that the prompt for the sales territory selection does not appear in the parameter 
toolbar above the report and that the report displays data only for the Pacific sales 
territory .

q Integrated mode: In the Reports Library list, point to the Pacific Reseller Sales 
Margin Analysis report, click the Edit button (which appears to the right of the 
report title), and select Manage Data Sources . Click the AdventureWorksDW2008 
link, and then click the ellipsis button to the right of the Data Source Link box . 
In the Select An Item dialog box, click Up, click the Data Connections link, select 
AdventureWorksDW2008, click OK twice, and click Close . Now that the data 
source information has been linked to the report, click the Pacific Reseller Sales 
Margin Analysis link to view the report, shown here .
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enabling	Personalized	Folders
On a native-mode report server, you can enable My Reports to give each user a 
personal workspace in which the user can store reports created using one of the 
report development tools for personal use . A user with appropriate permissions can 
also create a linked report to personalize a report, such as setting a specific parameter 
value when the report opens . To enable My Reports using SQL Server Management 
Studio, connect to Reporting Services, right-click the server in Object Explorer, select 
Properties, and then select the Enable A My Reports Folder For Each User check box . 
The tasks that a user can perform in this folder are controlled by the role settings that 
are described in Chapter 11 .

On an integrated-mode server, you can also provide a personal workspace for report 
storage, by creating a Shared Services Provider and configuring a My Site Location and 
personalization on the SharePoint server . (For more information, see the article “Create 
and Configure Shared Services Providers,” at http://technet.microsoft.com/en-us/library 
/cc303421.aspx .) A user with appropriate permissions can then click the My Site link 
at the top of the SharePoint site to create a personal site, and then use the Send To 
command (as described in the procedure entitled “Create a report copy” earlier in this 
chapter) to copy a report and personalize the parameter settings .

Configuring	Data	Source	Properties
You will likely design and test reports in BI Dev Studio by using a local data source that 
contains a representative subset of production data . By limiting the data used for report 
development, you can avoid long waits for report execution . On the server, however, you 
want reports to retrieve data from the production data sources . You can maintain one data 
source for your development environment and another for your server environment . The 
OverwriteDataSources property for the project controls whether the data source in your 
project gets copied to the server . By default, deployment copies the data source file the first 
time, but subsequent deployments ignore the data source file, allowing you to change the 
properties on the server without affecting the data source on your development computer .

Prompting the User for Credentials
The simplest type of security to implement is Windows integrated security, which passes 
the user’s credentials to the data source, but you might have data sources that don’t use 
Microsoft Windows credentials for authentication . For these situations, you can prompt 
the user for credentials, which then pass to the data provider for authentication at the data 
source . You should use this authentication method only for reports that the user can access 
on demand because the report cannot execute without user input .
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 In this procedure, you create a report-specifi c data source to prompt the user for credentials 
before executing the report . 

Confi gure prompted credentials

		 1.	 In Internet Explorer, open the Sales Summary report that you created earlier in this 
chapter . 

q  Native mode: In Report Manager, click the Home link at the top of the window, 
click the For Review link, and then click the Sales Summary link . 

q Integrated mode: In the address bar, type http://<servername>/sites/ssrs
/ReportsLibrary/For	Review	(replacing <servername> with the name of your server), 
or if viewing a report, click the Reports Library link at the top of the window and 
then click the Sales Summary link . 

A message displays explaining that the current data source connection information has 
been deleted . Remember that this report was uploaded directly to the report server 
and independently of any shared data source described in the report defi nition . You 
must either associate the report with shared data sources on the report server, or 
confi gure a report-specifi c data source . In this procedure, you create a report-specifi c 
data source to learn the proper steps . 

		 2.	 Open the data source properties page for the report . 

q Native mode: Above the report, click the Properties tab, and then click the Data 
Sources link . A message displays explaining that the data source reference is no 
longer valid . 

q Integrated mode: At the top of the window, click the For Review link, point to the 
Sales Summary report, and click the Edit button to the right of the report title, 
select Manage Data Sources, and click the AdventureWorksDW2008 link . A 
message displays explaining that the linked data source could not be found . 

	 3.	 Create a report-specifi c data source to connect to the AdventureWorksDW2008 data 
source . 

q Native mode: Select A Custom Data Source, and then, in the 
Connection String text box, type Data	Source=localhost;Initial	
Catalog=AdventureWorksDW2008; . 

 The default authentication when creating a new data source on the report server is 
Credentials Supplied By The User Running The Report, as shown here . 

Confi gure prompted credentials
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q Integrated mode: Select Custom Data Source, and then, in the Connection String 
box, type Data	Source=localhost;Initial	Catalog=AdventureWorksDW2008;, 
and then select Prompt For Credentials .

Before the user can view the report, the user must enter a user name and password . 
You can change the prompt that is displayed to the user in the Display The Following 
Text To Prompt User For A User Name And Password text box in native mode, or in the 
Provide Instructions Or Example box in integrated mode .

Important If the user must supply a Windows user account, be sure to select the Use As 
Windows Credentials When Connecting To The Data Source check box in native mode, or 
select Use As Windows Credentials in integrated mode .

	 4.	 Apply the change to the data source properties .

q Native mode: Click Apply .

q Integrated mode: Click OK, and then click Close .

	 5.	 View the report .

q Native mode: Above the data source properties, click the View tab . The prompt 
for credentials displays, as shown here . Type your user name and password, and 
then click View Report to display the report .
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q  Integrated mode: Click the Sales Summary link . The prompt for credentials 
displays . Type your user name and password, and then click Apply to display the 
report . 

 Important If you have confi gured Windows authentication for your SQL Server database 
engine, which is the default, be sure to include the domain name with your user name in 
the Log In Name box, using the Domain\User format . 

Using Stored Credentials
 Several execution methods require the data source to use stored credentials when the report 
runs on a scheduled basis or produces a report snapshot . The stored credentials are stored 
in the ReportServer database using reversible encryption . The account used for stored 
credentials must be granted Read permission on the source database . 

 In this procedure, you confi gure a shared data source to use stored credentials . 

Confi gure stored credentials

		 1.	 In Internet Explorer, open the AdventureWorksDW2008 data source that was deployed 
with your report project earlier in this chapter . 

 Important If you deployed the report model project in Chapter 9, you also see the 
Adventure Works DW2008 data source for the report model in the Data Sources folder . Be 
sure to select the correct data source . 

q  Native mode: In Report Manager, click the Home link at the top of the window, 
click the Data Sources link, and then click the AdventureWorksDW2008 link . 

q Integrated mode: Type http://<servername>/sites/ssrs/data	connections	
(replacing <servername> with the name of your server), and then click the 
AdventureWorksDW2008 link . 

	 2.	 Confi gure the stored credentials option . 

q  Native mode: Select Credentials Stored Securely In The Report Server, type your 
user name and password in the applicable text boxes, select the Use As Windows 
Credentials When Connecting To The Data Source check box if you are using 
Windows authentication in your SQL Server database, and then click Apply . The 
updated properties page for the data source is shown here . 

Confi gure stored credentials
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Note In this example, the server name in the User Name string is fictitious and is included 
for illustration purposes only .

q Integrated mode: Select Stored Credentials, type your user name and password in 
the applicable boxes, select the User As Windows Credentials check box if you are 
using Windows authentication in your SQL Server database, and click OK .

Important If you type an incorrect user name and password for a data source’s stored 
credentials, no error message displays . You must test a report using this data source to 
confirm the user name and password are correct, which you do in the next procedure .

Configuring	Report	execution	Properties
Report execution transforms a report stored in the ReportServer database into a rendered 
report that the user views . As part of the execution process, the queries defined in the 
report’s datasets execute and return data to the report server, which then uses the report 
definition file to determine how to construct the report with the retrieved data . At this point, 
the report is in an intermediate format that is sent to the applicable rendering extension to 
produce the final rendered report .

Report performance is determined largely by how much data is retrieved by the report and 
how much processing is required to produce the rendered report . If the users don’t need the 
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most current data in the database each time the report executes, you should consider any 
execution option that generates the report’s intermediate format in advance of the user viewing 
the report to achieve optimal performance . The following sections in this chapter explain the 
relationship between each execution option and generation of the intermediate format . 

Executing a Report on Demand
When a user clicks the link for a report, the report executes on demand, returning the most 
current data to the report server which then produces an intermediate format . The interme-
diate format is stored in the ReportServerTempDB database in a session cache to speed up 
subsequent requests by the same user for the same report during the current session . For 
example, after the user views the report online, the user might export the report to an Excel 
format . By having the intermediate format in session cache, the online version and the Excel 
version of the report match . Furthermore, the Excel version renders very quickly from the 
intermediate format of the report because the report server does not need to wait for the 
query to execute again . 

In this procedure, you confi gure the execution properties of the Employee Sales Moving 
Average report to execute on demand with a 60-second timeout . 

Confi gure report execution on demand with a 60-second timeout

	 1.	 In Internet Explorer, open the execution properties page of the Employee Sales Moving 
Average Report . 

q Native mode: In Report Manager, click the Home link at the top of the window, 
click the For Review link, click the Employee Sales Moving Average link, click the 
Properties tab, and then click the Execution link to view the execution properties, 
as shown here . 

Confi gure report execution on demand with a 60-second timeout
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q Integrated mode: In the navigation bar, click Reports, click the For Review link, point 
to Employee Sales Moving Average, click the Edit button appearing to the right of 
the report title, and select Manage Data Sources . Click the AdventureWorksDW2008 
link, and then click the ellipsis button to the right of the Data Source Link box . In 
the Select An Item dialog box, click Up twice, click the Data Connections link, select 
AdventureWorksDW2008, click OK twice, and click Close . Now the link to the data 
source, which was broken when you moved the report to the For Review folder, 
is fi xed, and you can proceed to set the execution properties . Point to Employee 
Sales Moving Average, click Edit, and then select Manage Processing Options . 

The two execution properties for a report are the type of execution and the report 
execution timeout, as shown in the following table . 

For This Property Type On a Native-Mode Report 
Server, the Default 
Property Is

On an Integrated-Mode Report 
Server, the Default Property Is

Execution type Do Not Cache Temporary 
Copies Of The Report

Use Live Data

Execution timeout Use The System Default 
Setting

Use Site Default Setting

You learn how to confi gure the System/Site default setting in Chapter 12, “Performing 
Administrative Tasks,” if you want to use a value other than the 1,800-second default 
for all reports . Alternatively, you can override this value, as shown in the next step . 

	 2.	 Change the report execution timeout value to 60. 

q Native mode: In the Report Execution Timeout section, select Limit Report 
Execution To The Following Number Of Seconds, and then, in the text box to the 
right, type 60, and click Apply . 

q  Integrated mode: In the Processing Time-out section, select Limit Report 
Processing (In Seconds), and then, in the text box to the right, type 60, and click 
OK . 

	 3.	 View the report to confi rm execution on demand . 

q Native mode: Click the View tab and note the date-time stamp below the chart . 

q Integrated mode: Click the Employee Sales Moving Average link and note the 
date-time stamp below the chart . 

	 4.	 Above the report title, click the For Review link, click the Employee Sales Moving 
Average link, and then note the new date-time stamp below the chart . 

For This Property Type On a Native-Mode Report 
Server, the Default 
Property Is

On an Integrated-Mode Report 
Server, the Default Property Is
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Caching Reports
 Caching a report is helpful when you want to strike a balance between having current data 
in the report and having faster access to the online report . The fi rst time a user clicks the link 
for a report confi gured to cache, the report execution process is identical to the on-demand 
process . However, the intermediate format is fl agged as a cached instance and stored in 
ReportServerTempDB until the time specifi ed by the cache settings expires . Meanwhile, if any 
user requests the report during the time that it still resides in cache, then the report server 
retrieves the intermediate format and renders the report so long as the user requests the 
same combination of parameter values . This process is much faster than retrieving the data, 
producing the intermediate format, and then rendering the report . 

If a user requests a different set of parameter values for a cached report, then the report 
processor treats the request as a new report executing on demand, but fl ags it as a second 
cached instance . If users are constantly looking at different parameter combinations and not 
reusing parameter values, then using cached reports is not helpful . 

In this procedure, you confi gure the execution properties of the Employee Sales Moving 
Average report to cache the report and expire the cached instance after 60 minutes . 

Confi gure caching with expiration after 60 minutes

	 1.	 In Internet Explorer, open the execution properties page of the Employee Sales Moving 
Average report . 

q Native mode: Open the report, if necessary, click the Properties tab, and then click 
the Execution link to view the execution properties . 

q Integrated mode: If the report is open, click the For Review link . Otherwise, 
type http://<servername>/sites/ssrs/ReportsLibrary/For	Review (replacing 
<servername> with the name of your server), point to Employee Sales Moving 
Average, click the Edit button (located to the right of the report title), and then 
select Manage Processing Options . 

		 2.	 Set the execution type to caching with an expiration after 60 minutes . 

q Native mode: Select Cache A Temporary Copy Of The Report, and then, in the 
Expire Copy Of The Report After A Number Of Minutes text box, type 60 . Click 
Apply . 

q Integrated mode: Select Use Cached Data, and then, in the Elapsed Time In 
Minutes text box, type 60, as shown here, and click OK . 

Confi gure caching with expiration after 60 minutes
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	 3.	 View the report to confirm execution .

q Native mode: Click the View tab and note the date-time stamp below the chart .

q Integrated mode: Click the Employee Sales Moving Average link .

	 4.	 Above the report title, click the For Review link, click the Employee Sales Moving 
Average Report link, and then note the date-time stamp below the chart has not 
changed to reflect the current time .

	 5.	 In the Employee drop-down list, select Campbell, David, click View Report or Apply 
(as applicable to your report server), and then note the new date-time stamp .

	 6.	 In the Employee drop-down list, select Pak, Jae, click View Report or Apply as appli-
cable, and then note the date-time stamp for the first cached instance of the report .

Creating Report Snapshots
When users don’t need up-to-the minute data from the data source, and also need fast 
report performance, you can use report snapshots . A report snapshot executes the query 
and produces the intermediate format in advance of the user’s request to view the report . 
You can configure a report to generate a snapshot on demand, or you can set up a recurring 
schedule to replace a snapshot periodically with a more current version . The intermediate format 
of the report has no expiration time like a cached instance, and is stored in the ReportServer 
database as part of permanent storage . If you have limited disk space, you should monitor 
the growth in your ReportServer database, as described in Chapter 12 .
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 If you decide to create a report snapshot on a recurring schedule, you can choose between a 
report-specifi c schedule and a shared schedule . The benefi t of using a shared schedule is the 
ability to apply the schedule to several different activities, such as creating snapshot, expiring 
caches, or delivering subscriptions . 

 In this procedure, you confi gure the Sales and Average Sales report to execute as a report 
snapshot on a weekly schedule . 

Confi gure a report as a scheduled snapshot

		 1.	 Click Start, select All Programs, Microsoft SQL Server 2008, Confi guration Tools, and 
click SQL Server Confi guration Manager . Then select SQL Server Services in the tree 
view on the left, right-click SQL Server Agent in the detail view on the right, and, if the 
state of the SQL Server Agent is stopped, select Start . Close SQL Server Confi guration 
Manager . 

 Important The SQL Server Agent must be running to create and execute schedules . If 
you later stop or disable the SQL Server Agent, any schedules that were missed do not 
execute . 

		 2.	 Switch to Internet Explorer, and open the execution properties page of the Sales and 
Average Sales report . 

q  Native mode: In Report Manager, click the Home link at the top of the win-
dow, click the For Review link, click the Sales And Average Sales link, click the 
Properties tab, and then click the Execution link to view the execution properties . 

q Integrated mode: If the report is open, click the For Review link . Otherwise, 
type http://<servername>/sites/ssrs/ReportsLibrary/For	Review	(replacing 
<servername> with the name of your server), point to Employee Sales Moving 
Average, click the Edit button (located to the right of the report title), and then 
select Manage Processing Options . 

		 3.	 Set the execution type to a report execution snapshot using a report-specifi c schedule . 

q Native mode: Select Render This Report From A Report Execution Snapshot, select 
the Use The Following Schedule To Create Report Execution Snapshots check box, 
and then click Confi gure . 

Note If a shared schedule exists, you can select the Shared Schedule option, and select 
the shared schedule in the corresponding drop-down list . You can confi gure server-wide 
schedules by clicking the Site Settings link at the top of the window, clicking the Schedules 
link, and then clicking New Schedule . You then specify the schedule details on the 
Scheduling page, which looks very similar to the page that you confi gure in the next step . 

Confi gure a report as a scheduled snapshot
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q Integrated mode: Select Use Snapshot Data, select the Schedule Data Processing 
check box, and then click Configure .

Note If a shared schedule exists, you can select the On A Shared Schedule option, and 
select the shared schedule in the corresponding drop-down list . You can configure server-
wide schedules by clicking the Site Actions button at the top of the window . Click Site 
Settings, click Modify All Site Settings, click Manage Shared Schedules in the Reporting 
Services section, and click Add Schedule . You then specify the schedule details on the 
Scheduling page, which looks very similar to the page that you configure in the next step .

	 4.	 Configure a weekly schedule to create the snapshot each Monday at 6:00 AM, ending 
in two weeks .

q Native mode: Select Week, and then, in the first Start Time text box, replace 
the current value with 06 . Select the Stop This Schedule On check box, click 
the Calendar icon, and select a date two weeks into the future, as shown here . 
Click OK .

q Integrated mode: Select Week, and then, in the Start Time box, replace the current 
value with 6:00 . Select Stop Running This Schedule On, click the Calendar icon, 
select a date two weeks into the future, and click OK .
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Note In this procedure, a specific end date for the schedule is specified to limit the num-
ber of times the report executes on a schedule . In a production system, you are more likely 
to omit specifying an end date for the schedule to keep creating the report snapshot on 
an ongoing basis .

	 5.	 Apply the new execution properties .

q Native mode: On the execution properties page, shown here, click Apply .

q Integrated mode: On the Manage Processing Options: Employee Sales Moving 
Average page, click OK .

Notice that the Create A Report Snapshot When You Click The Apply Button On This 
Page check box is selected by default on this page on a native-mode report server . 
On an integrated-mode server, the equivalent option is the Create Or Update The 
Snapshot When This Page Is Saved check box . You can create a snapshot on demand 
without waiting for the scheduled snapshot by opening this page, selecting this check 
box, and saving the page by clicking Apply on a native-mode report server or by click-
ing OK on an integrated-mode report server .

	 6.	 View the report snapshot label in the For Review folder .

q Native mode: Above the execution properties, click the For Review link to view the 
snapshot label, shown here .



 Chapter 10 Deploying Reports to a Server 329

q Integrated mode: After you click OK in the previous step, the contents of the For 
Review folder displays . However, there is no indicator that the report is now a 
snapshot report . The Report Modifi ed date-time stamp displays the execution 
time of the snapshot after you refresh the browser . 

Each time you click the report link to view the report snapshot, the execution date-time 
refl ects the execution time of the snapshot . Note that the user cannot change any 
report parameter that passes a value to a query parameter . The report parameter is 
visible in the toolbar, but it is disabled . 

 When a new snapshot is created according to the defi ned schedule, the former snap-
shot is removed . Only the most current snapshot is available for viewing unless you 
confi gure report history, which you learn how to do in the next procedure . 

Saving Report Snapshots in Report History
By default, a new report snapshot replaces the previous report snapshot . You can choose to 
accumulate report snapshots in report history to preserve a record of the report contents at 
specifi c points in time . To add a report snapshot to report history, you can click a button to 
add it manually, or you can add to report history each time a new report snapshot is created 
according to the defi ned schedule . 

Because snapshots can require a lot of storage space, you might want to impose a serverwide 
limit to the number of snapshots that can accumulate for a report, or you can set a limit 
specifi c to each report . 

In this procedure, you confi gure report history and manually add a report snapshot to report 
history . 

Confi gure report history

	 1.	 Open the History page of the Sales and Average Sales report . 

q Native mode: In Report Manager, click the Sales And Average Sales link, click the 
Properties tab, and then click the History link to view the history properties, as 
shown here . 

Confi gure report history
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q Integrated mode: In the For Review folder of the Reports Library, point to 
the Sales And Average Sales report, click the Edit button (which appears 
to the right of the report title), and select Manage Data Sources . Click the 
AdventureWorksDW2008 link, and then click the ellipsis button to the right of the 
Data Source Link box . In the Select An Item dialog box, click Up twice, click the 
Data Connections link, select AdventureWorksDW2008, click OK twice, and click 
Close . Now, to view the history properties, select the Sales And Average Sales 
report, click Edit, and then click Manage Processing Options .

Select the Allow Report History To Be Created Manually check box to enable the user 
to create a report history snapshot on demand . The report history snapshot is differ-
ent from the snapshot you created in the previous procedure because it is accessible 
only on the History tab of the report on a native-mode report server, and on the View 
History page on an integrated-mode server, where you can accumulate multiple snap-
shots in report history . The New Snapshot button appears on the History tab when this 
option is enabled .

As an alternative to creating report history manually, you can select the Use The 
Following Schedule To Add Snapshots To Report History check box on a native-mode 
report server . On an integrated-mode report server, select the Create Report History 
Snapshots On A Schedule check box .

	 2.	 Configure the option to store each report execution snapshot in report history .

q Native mode: Select the Store All Report Execution Snapshots In History check 
box, and click Apply .

q Integrated mode: Select the Store All Report Data Snapshots In Report History 
check box, and click OK .
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Note Only report execution snapshots created after you enabled this option are stored in 
report history . 

Because report history consumes storage space in the ReportServer database, you 
should carefully manage the number of snapshots that accumulate in report history . 
You learn more about how to change the server-wide defaults in Chapter 12 . The 
options for applying a snapshot limit are described in the following table . 

To Set This Type of 
Snapshot Limit

On a Native-Mode Report 
Server, Use This Option

On an Integrated-Mode Report 
Server, Use This Option

Default Default Setting Use Site Default Setting

Specifi c number Limit The Copies Of Report History Limit Number Of Snapshots To

No limit Keep An Unlimited Number Of 
Snapshots In Report History

Do Not Limit the Number Of 
Snapshots

	 3.	 Create a report snapshot manually . 

q  Native mode: Click the History tab, and then click the New Snapshot button . The 
report snapshot appears in a list on the History tab . 

q Integrated mode: Select the Sales And Average Sales report, click Edit, click View 
Report History, and click New Snapshot . 

 The list of report snapshots in history includes the date and time the report snapshot 
was created and the total size of the report . You can delete a report by selecting its 
check box, and clicking the Delete button on the toolbar . 

Managing	Change	in	the	Reporting	Life	Cycle
 When report modifi cations are required to fi x issues during testing or to accommodate 
changing business requirements, you must edit the report defi nition fi le and then rede-
ploy the report . You can redeploy the report using any of the methods described previ-
ously in this chapter . The deployment process replaces the original report defi nition in 
the ReportServer database with the new report defi nition . All existing report properties 
are preserved, so you won’t need to change execution settings or security permissions 
when you redeploy a report, for example . However, be aware that because parameter 
properties are preserved, any changes you make to report parameters in the report 
defi nition are visible when you view the report on the report server after deployment . 
You must fi rst delete the report from the report server and then deploy the report to 
enable access to report parameter settings in the report defi nition . 

To Set This Type of 
Snapshot Limit

On a Native-Mode Report 
Server, Use This Option

On an Integrated-Mode Report 
Server, Use This Option
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Chapter	10	Quick	Reference

 To Do This

 Set report server project 
properties

In Solution Explorer, right-click the project, select Properties, and 
then specify a target data sources folder, a target report folder, 
and the target report server URL .

 Deploy a report server project In Solution Explorer, right-click the project, and select Deploy .

 Upload a report to the report 
server

Native mode: In Internet Explorer, open Report Manager, navigate 
to the folder in which to store the report, click the Upload File 
button on the Report Manager toolbar, click Browse, navigate to 
the report on the fi le system, and select the report defi nition fi le .

Integrated mode: In Internet Explorer, open the reports library on 
the SharePoint site, click the Upload button on the reports library 
toolbar, click Browse, navigate to the report on the fi le system, and 
select the report defi nition fi le .

 Deploy reports with the Rs util-
ity on a native-mode report 
server

Create a script fi le that uses the CreateFolder and CreateReport 
methods, and provide the path to this script file as an input 
argument for the Rs utility by using the following syntax: rs –i in-
putfi le –s http://<servername>/ReportServer .

 Add a folder to a report server Native mode: In Report Manager, navigate to an existing folder, 
and click the New Folder button on the Report Manager toolbar .

Integrated mode: In the SharePoint reports library, on the reports 
library toolbar, click the arrow on the New button, and select 
Folder .

 Move a report to a new folder Native mode: In Report Manager, navigate to the report’s parent 
folder, click the Show Details button on the Report Manager tool-
bar, select the report’s check box, click the Move button, and select 
a target folder .

Integrated mode: In the upper-right corner of a page in the 
SharePoint site, click Site Actions, select Manage Content And 
Structure, select Reports Library in the tree view, select the report’s 
check box, click the arrow on the Actions button, select Move, and 
select a target folder .

 Create a linked report on a 
native-mode report server

In Report Manager, open the base report, click the Properties tab, 
click Create Linked Report, provide a name for the linked report, 
and then, if you want, click Change Location and select a target 
location .

 Create a report copy on an 
integrated-mode report server

In a SharePoint site, in the navigation bar, click Reports, point to a 
report in the library, click the Edit button appearing to the right of 
the report title, select Send To, click Other Location, type the name 
of a target document library or folder, and type a name for the 
report copy .

To Do This
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To Do This

Confi gure report parameter 
properties

Native mode: In Report Manager, open the report, click the 
Properties tab, click the Parameters link, and, if you want, clear the 
Has Default check box, provide an alternate default value, select 
the Hide check box, clear the Prompt User check box, or change 
the Display Text for the report parameter prompt .

Integrated mode: In the SharePoint reports library, point to the 
report, click the Edit button appearing to the right of the report 
title, select Manage Parameters, click a parameter link, and, if 
you want, select a new default value, select Do Not Use A Default 
Value, change the Prompt text, or hide the parameter by selecting 
Hidden or Internal .

 Confi gure a data source Native mode: In Report Manager, open the shared data source 
or open a report, click the Properties tab, click the Data Sources 
link, select A Custom Data Source, select a data source type, and 
provide a connection string . Select the applicable Connect Using 
option to confi gure one of the following authentication methods: 
prompted credentials, stored credentials (which requires supplying 
the login name and password), Windows integrated security, or no 
credentials .

Integrated mode: In SharePoint, open the Data Connections folder 
on the site, and select a data source link or, in a reports library, 
point to a report, click the Edit button appearing to the right of 
the report title, select Manage Data Source, click the data source 
link, and select Custom Data Source . Select a data source type, 
and provide a connection string . Select the applicable Credentials 
option and confi gure one of the following authentication methods: 
Windows integrated security, prompted credentials, stored creden-
tials (which requires supplying the login name and password), or 
the unattended report processing account .

 Confi gure report execution 
properties

Native mode: In Report Manager, open the report, click the 
Properties tab, click the Execution link, and then specify an 
execution type (on demand, caching, or snapshot) and a report 
execution timeout setting .

Integrated mode: In SharePoint, open the reports library, point to a 
report, click the Edit button located to the right of the report title, 
select Manage Processing Options, and then specify an execution 
type (on demand, caching, or snapshot) and a report execution 
timeout setting .

 Enable report history Native mode: In Report Manager, open the report, click the 
Properties tab, click the History link, and select a method for 
adding snapshots to report history and a limit to the number of 
snapshots to keep in report history .

Integrated mode: In SharePoint, open the reports library, point to a 
report, click the Edit button located to the right of the report title, 
select Manage Processing Options, and select a method for adding 
snapshots to the report history and a limit to the number of snap-
shots to keep in report history .

To Do This
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in Reporting Services installation, 27



installing, 29–30, 33
parameters for, 233–239

custom query, 236–239
in datasets, 233–236

Quick Reference guide on, 240
report models and, 270
sample database for, 216–218

And operator, 450
anomalies, charts and, 241
anonymous access authentication, 16–17, 55
APIs (application programming interfaces), 7, 9
application domains, 16
application pools, 26, 58, 408–409
applications

as architecture tier, 9–12
corporate, 7
custom, 5
in reporting platform, 3
in SharePoint integrated mode, 54
monitoring database size of, 386–387
portal, 7
ReportViewer control in, 517–521
to list report server settings, 506–509
Web, 56–58

approving reports, 348
architecture

application tier in, 9–12
data tier in, 8
for SharePoint integrated mode, 17–19
server tier in, 13–17

area charts, 244, 439
arguments, in programming, 489, 493
ASP .NET technology

application domain layer hosting of, 16
forms authentication in, 16, 383
user permissions for, 61–62

assemblies of code, 491–496, 522
attachments, reports sent as, 464, 466
attacks, lockdown strategy against, 385
attributes

alignment of, 282
appearance properties of, 282–283
Autogenerate command and, 293
DefaultDetailAttributes property for, 286
in report models, 277–279, 281
of entities, 285–286
properties of, 296
security of, 354

AttributesReference Collection Editor, 286, 288–289
authentication

anonymous access, 17, 55
connection string for, 8
Credentials Supplied By The User Running The Report 

as, 318
data sources for, 71, 108
extensions for, 14
in Report Server configuration, 382–383
in service architecture, 16

Kerberos, 55, 57
NTLM (NT LAN Manager), 57
Service Credentials, 52
settings for, 395
to confirm identity, 335
Windows, 55, 109, 170, 218, 317, 339

authoring, 9–10
authorization policies, 337–338
Auto Execute toolbar button, in query designer, 221
Auto Hide feature, 107–108, 115
Auto-fit option, 253
Autogenerate command, 293
Average function, 121, 154
axes, of charts, 10, 242, 256–258, 440

B
background colors, 136, 185, 229
background processing, 16
BackgroundRepeat drop-down list, 164
backup encryption key, 45, 63
bar charts, 243, 439
basic authentication, 382
batch mode, 11
blue snap line, for alignment, 127, 131, 251
Bold button, 137
Bollinger bands, for financial charts, 254
bookmarks, 203–205, 421, 424
borders, 68, 75, 136, 242
BorderStyle property, 162
branch offices, SQL Server 2008 Workgroup for, 22
browser role, subscriptions and, 465
Build command, 491
Builder functions, 202
built-in fields

for expressions, 152–153
in Report Data pane, 66, 107

Business Intelligence Development Studio (BI Dev 
Studio) . See also Designing reports

Analysis Services shared data source creation 
 in, 218

chart creation in, 245
custom functions developed in, 488
dashboard creation in, 415
deployment from, 299, 304
installing, 29–30
local data source for, 317, 350
Model Designer in, 9
My Reports folder and, 405
overview of, 9
Report Formatting toolbar in, 137
report model creation in, 269, 280, 294
ReportViewer control and, 517
RSreportserver .config file edited in, 377, 380–381, 

383–384
securing data and, 362, 364
trace log configuration and, 388–389
Web applications to view reports from, 436
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C
caching reports

execution properties to implement, 92, 94
in deployment to servers, 324–325
null delivery provider and, 14
ReportServerTempDB database for, 13, 387
session for, 322

calculations, 5
as expressions, 146–149
for charts, 254–256
formula fields for, 113, 179, 446–447
in current cube, 215, 220–221
in MDX (Multidimensional Expression) queries, 

223–226, 240
support for, 10
variables for, 10

Calendar control, 236–237, 239, 327
Cancel All Jobs command, 373
Cancel Query toolbar button, in query designer, 222
cascading parameters, 200–201, 213
case sensitivity, 113, 156
CASE statements, 487
catalog table, in ReportServer database, 304
category (x) axis, of charts, 242
category drop zone, 246
Centered button, 444
Central Administration, 54, 57, 59
certificates, 17, 38
change permission, 469
charts, 241–262

calculated series in, 254–256
column, 245–247
combining types of, 258–260
data region for, 10
formatting, 247–250
of linear data, 243–244
of multi-value data, 245
of ratio data, 244
overview of, 242
Report Builder for, 432, 439–442
report processing extensions for, 14
scale breaks in, 250–253
second area in, 260–262
secondary axis in, 256–258

child gauges, 263
child groups, 129
Choose program flow function, 162
ChunkData table, 386–387
class libraries, for code assemblies, 491–494
clickthrough reports, 454–461 . See also drillthrough 

reports
configuring, 457–459, 462
infinite, 22
opening, 454–456, 462
Report Models for, 459–462

Client Tools Connectivity, 29–30
Clip option, 164

Clipboard, 68, 172
CLR (common language runtime) integration, 16
clusters, 23, 244
code

assemblies of, 491–496, 522
embedded, 487–491, 522

CodePlex community, 48, 216
collateral resources, 24
collation, in datasets, 113
colors

background, 136, 185, 229
coding by, 265
conditional formatting of, 162–163
fill, 444
font, 84
Report Project Wizard and, 105
text, 137

column charts, 242–243, 245–247, 258, 266, 439
column headers, pinning, 184
column titles, for tables, 77
Command Type MDX, 221
command-line utilities

Add New Report, 105–106
Add Total, 121
Autogenerate, 293
Build, 491
Cancel All Jobs, 373
Deploy, 289
Edit as Formula, 449
for publishing reports, 12
for repetitive tasks, 12
Insert Table, 98
overview of, 12
Remove Prompt, 449
Rs, 12, 306–307, 332, 498, 501, 523
Rsconfig, 377–381
Run, 68
to update connection information, 377
URL access, 510

commas, embedded, 427
complex expressions, 145
complex report models, 281
compound expressions, 145
Computer Management console, 336
concatenation

expression for, 283–285
in linking report and query parameters, 199
of strings, 5

Condition argument, 489
condition groups, 450
conditional expression, 173
conditional formatting

expressions for, 162–164
extended field properties for, 229
in recursive hierarchies, 176, 179

Connection Properties dialog box, 109
connection strings, 319

authentication and, 8
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data source and, 69
dynamic, 169–171, 180
for shared data sources, 109

connectivity, 29, 390 . See also ODBC (Open Database 
Connectivity)

content . See also Security; also Security of content
filtering parameters for, 6
folders to organize, 307–308
for SharePoint document libraries, 60–61
management tools for, 11–12
moving, 309–311
organizing, 5

Content Manager role
My Reports folder feature and, 372
Report Builder and, 435
securing folders and, 348
subscriptions and, 465, 474, 479
to deploy reports, 299, 343

Content Sources and Crawl Schedules link, 410
Contribute permissions, 341, 354
contribution percentage, 161
controls, from Toolbox window, 115, 127–129, 131, 155
copying reports

for security, 359–360
in deployment to server, 313–314, 332

corporate applications, 7
Count function, 154, 245
CountDistinct function, 154
CountRows function, 154
crawl schedules, 410
CreateFolder method, 498–499
CreateReport method, 498
credentials

data source, 94
for report server database, 51–52
for SharePoint for Reporting Services integration, 55
in dynamic connection string creation, 170
prompt for, 71, 317–320
stored, 320–321
to open Report Manager, 382

CSV (Comma-Separated Value) format
exporting reports in, 425–427
overview of, 7
rendering extensions for, 14–15
viewing reports in, 117

cubes, OLAP (online analytical processing) database as, 
215, 220, 225, 227, 240

currency rates, expressions for, 167
custom authentication type, 383
custom query parameters, 236–239

D
dashboards

access to reports by, 415–419
description of, 10, 17
Report Viewer Web Parts in, 428

Data Connections library, 276, 301
data drop zone, 246, 259

data exchange, 425–427
Data pane, 221
data processing extensions, 14
Data Refresh Options, 94
data regions

adding, 114–115
adjacent groups in, 129–130
aggregate functions in, 157–160
binding data to, 115–117
definition of, 67
drag-and-drop to move, 135
group relationships in, 118
grouping data in, 117–121
in layouts, 142
in report building, 226
lists as, 126–128
matrix as, 123–126
sorting in, 183
tables as, 75
tablix as, 79, 129
totals in, 121–123

Data Source View (DSV)
in report models, 270–275, 295
updating, 294–295

data sources
adding, 98
Analysis Services, 218–219
assigning, 523
credentials for, 94
deployment to servers and, 317–321, 333
disabling shared, 374–376
embedded, 105
for subscription delivery tables, 476
identifying, 66, 69–71
in architecture tier, 8
in report models, 269–270, 295
item-level security for, 350
parameter configuration and, 316
Report Designer to create, 108–111
security, 346
shared

assigning, 523
creating, 109–111, 142
disabling, 374–376
folder for, 218
in Report Models, 277
Report Project Wizard and, 105

templates for, 106
variety of, 5

Database Engine Services, 29–30, 32, 34, 387
Database Name and Authentication, 58
databases, temporary, 24
data-driven documents, 422–424
data-driven subscriptions, 474–478, 483
DataSetName property, 116
datasets

adding, 98
Analysis Services, 218–226

calculation added to query for, 223–226
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data source in, 218–219
in reports, 226–227
parameters in, 233–236
query for, 219–223

creating, 142
defining, 66, 71–73
dynamic, 171–173, 180
empty, 199
expressions for, 169–173
filters for, 193–194, 213, 364–365
for interactivity parameter values, 195–197
properties of, 146, 363
Report Designer to create, 111–114

date-time report parameter, 192–193
default aggregate attributes, 279
Default Content Access Account link, 410
Default Target Server, for Report Builder, 47
DefaultDetailAttribute property, 286, 455–456
DefaultTraceSwitch setting, 388
Define Formula dialog box, 447
Definition variable, 499
Delete toolbar button, in query designer, 221
delimiter strings, 203
delivery of reports . See also Scheduling and Delivery 

Processor; also Subscriptions
background processing management of, 16
disabling, 386
extensions for, 14, 473
performance of, 8
programmatic interface for, 11
SOAP (Simply Object Access Protocol) endpoint  

and, 19
dependency, in cascading parameters, 200
deployment . See also Scale-out deployment

accessing content after, 343
distributed, 52
of Analysis Services, 217–218
of report models, 296
programming scripts for, 498–502, 523
to servers, 299–333

caching reports in, 324–325
copying reports in, 313–314
data source properties in, 317–321
folders to organize content in, 307–308
linked reports in, 311–312
moving content in, 309–311
of report projects, 300–304
on-demand execution of reports in, 322–323
parameters configured for, 314–317
Quick Reference guide on, 332–333
reporting life cycle and, 331
Rs utility for, 306–307
snapshot reports in, 325–331
uploading reports to, 304–306

topology for, 23–24
descriptions of reports, 88–92
Design Mode toolbar button, in query designer, 222
Design view, 68, 86

designing reports, 103–144
appearance enhancements in, 135–142

for print-ready formats, 139–141
page breaks in, 138–139
page headers and footers in, 141–142
report item placement and size in, 135–136
report item properties in, 136–138

assemblies of custom code for, 491–496
data regions in

adding, 114–115
adjacent groups in, 129–130
binding data to, 115–117
grouping, 117–121
list as, 126–128
matrix as, 123–126
tablix as, 129
totals in, 121–123

embedding code for, 487–491
images in, 132–133
lines in, 131
Quick Reference guide on, 142–144
Report Designer for, 103–114

data source created in, 108–111
datasets created in, 111–114
Report Server project in, 104–105
reports added in, 105–108

subreports linked in, 134–135
text boxes in, 130–131

detail rows
aggregate values in, 230–233
grouping of, 77
sorting by, 183

development of reports
overview of, 4–6
tools for, 9–10

digest authentication, 17
dimension tables, 48
disk space, 24–25, 31
Disk Usage by Top Tables report, 387
distributed deployment, 52
document libraries

content types for, 60–61
in SharePoint, 10
report description added to, 90–92
viewing reports in, 96

document maps, 6, 204–205, 213, 412, 421
documents, data-driven, 422–424
domain accounts, for services, 32
doughnut charts, 244, 439
drag-and-drop, data regions moved by, 135
drillthrough reports, 13 . See also clickthrough reports

entities for, 296
Report Builder and, 436
report models for, 280, 286–289
summary and detailed data in, 185–188

dynamic connections, expressions for,  
169–173, 180

dynamic filters, 448
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e
Edit as Formula command, 449
e-mail delivery

exporting reports for, 419
extensions for, 14
HTML markup for, 208–211
of reports, 11
Scheduling and Delivery Processor for, 13
subscriptions for, 43, 464–468, 474, 482

embedded code, 487–491
embedded commas, 427
embedded data sources, 70, 105
embedded images, 132–133, 143
embedded reports, 4, 9–10, 20
EnableDrillthrough property, 455
EnableRemoteErrors property, 373
encryption, in Report Server configuration, 377–381
entities

Autogenerate command and, 293
expressions in, 296
for drillthrough reports, 296
in report models, 277, 285, 432–433
instances of, 285–286, 296
security of, 354

equals operator, 449
Error and Usage Reporting page, 35
error messages, 60, 361
evaluation, expression, 165–167
Event Viewer, 62
Excel spreadsheets, 4

CSV (Comma Separated Values) files opened in, 426
dashboards and, 415
exporting reports as, 421–422
rendering extensions for, 14–15
viewing reports as, 117

Excel Web Access Web Parts, 416
exchange, of data, 425–427
Execute Query toolbar button, in query designer, 222
execution of reports . See also Memory

logging, 370, 372
on-demand, 6, 333

disabling, 386
in deployment to servers, 322–323
Report Processor for, 13

properties for, 92–94
subscriptions and, 468
suspending, 373–376, 395
time-out setting for, 372–373

expiration, of caching, 324–325
exporting reports, 117, 419–428

as data-driven documents, 422–424
for analysis, 421–422
for data exchange, 425–427
for online viewing, 419–420
for printing, 424–425

expressions, 145–180
builder functions for, 202
built-in fields for, 107, 152–153

calculated, 10, 146–149
calculated series and, 255
case sensitivity of, 78
conditional formatting by, 162–164
custom assemblies in, 494–496
custom functions in, 490–491
dialog box for, 81
embedded code for, 488–489
Excel format and, 422
for aggregate functions, 154–160

in data regions, 157–160
Scope argument as, 154–157

for date-time parameters, 193
for dynamic connections and datasets, 169–173
for dynamic queries, 111
for gauges, 264
for hierarchical data, 173–179
for report models, 283–285, 296
for shared data sources, 109
HTML markup tags in, 208
in Bookmark property, 205
in data drop zone, 259
loops as, 487
multiple group, 120
parameter, 190
placeholder displays for, 77–78
Quick Reference guide on, 179–180
report item, 150–152
securing data and, 363
sorting by, 160–162, 183
Sum function as, 121
text box, 149–150
updating, 293
variables in, 164–168

extended field properties, in Analysis Services,  
227–229

extensions
authentication, 14
data processing, 13–14
for report delivery, 14, 473
Null Delivery Provider, 473
rendering, 14
report processing, 14
 .rss file, 306
server, 13, 20

F
fact tables, 48
failover clusters, 23
fax devices, delivery to, 14
field expressions, 145
field lists, 71, 78, 80, 124
Field Source text box, 147
fields

for report models, 432–433
formula, 446–449, 462
in tables, 115–117
string, 128
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filename variable, 499
filePath variable, 499
file share, delivery extensions for, 14
FileSizeLimitMb setting, 388
fill color, 444
fill property, 242
filtering

by date, 237–239
cube data limited by, 220, 222
dataset, 113, 120, 213, 240, 364–365
entity instances for, 285
gauges for, 263
InstanceSelection property and, 275
interactivity parameters for, 193–195
of ad hoc reports, 448–451, 462
parameters for, 6, 234–236
permissions table and, 360
Report Builder and, 280

Find box, 167
First function, 128, 154
fluctuations, moving average charts and, 256
folders

content organized by, 300, 307–308
for report servers, 332
item-level security for, 346–350
personalized, 317

FontFamily property, 162
fonts, 68

color of, 164
for charts, 242, 440
in report design, 105, 136–137, 140

FOR statements, 487
foreign key column, in tables, 173–174, 272, 278
formats, 4, 471, 474–475 . See also CSV (Comma-

Separated Value) format; also Excel spreadsheets; 
also HTML (Hypertext Markup Language); 
also Microsoft Office Word; also PDF (Portable 
Document Format) files; also TIFF (Tagged Image 
File Format) files; also XML (Extensible Markup 
Language)

FormattedValue property, 265
formatting

ad hoc reports, 444–446, 462
attributes, 282
charts, 247–250, 266, 442
clickthrough reports, 458
conditional, 162–164, 176, 179, 229
Excel spreadsheets, 421
hierarchical data, 173
HTML markup tags for, 208
in calculated member definition, 225
numerical, 249
secondary axis of charts, 256
setting properties for, 98
simple reports, 84–86
values, 227–229, 240
Word documents, 422

formula fields, for ad hoc reports, 446–449, 462

free-form text boxes, 5
FriendlyName property, 272, 274
Full Control permissions, 341, 354
full crawl schedules, 410
full screen mode, 403
funnel charts, 244

G
Gantt charts, 245
gauges

creating, 262–267
data region for, 10
for key performance indicators, 5

GetStatus function, 490
global report information, 179
globally unique identifier (GUID), 293
Globals collection, for complex expressions, 152
Go To Bookmark action, 206
Go To Report action, 205–208, 213
Go To URL action, 206
Goal Variance calculated member, 225–226
goal variance, gauge for, 264
Grant Database Access page, 54
graphical user interface (GUI), 5, 11
Grid pane, 273
grouping

adjacent, 129–130
chart category axis for, 242
condition, 450
data, 117–121, 143
disabling interactive, 453–454
for subtotal display, 5
gauges and, 263
in Report Builder, 451–452
in Report Server Project Wizard, 105
list support of, 126
of hierarchical data, 173–175
of parent rows, 98
of variables, 10, 165–167
page breaks and, 82–84
tables for, 79–82
XML file preservation of, 427

Grouping pane
details row group in, 77
fixed column headers and, 185
in Report Designer window, 107
overview of, 66–67
page breaks and, 138–139

H
handles, on tables, 80, 85
hardware requirements, 24–25
headers and footers

Add Group, 81
adding, 144
as appearance enhancements, 141–142
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definition of, 67
field lists and, 80
fixed, 184–185, 212
in Word document format, 422
of subreports, 134
page numbers in, 153
report titles in, 74–75
table titles in, 77

Height property, 422
hidden value, of parameters, 169
hierarchical data, 5, 173–179
high memory pressure, 384
highlighting values, conditional formatting for, 162–164
history, report

ChunkData table and, 386–387
saving report snapshots in, 329–331, 333
SSMS and, 370, 372

home folder, 400
Horizontal rotation property, 441
hostfolder variable, 500
HTML (Hypertext Markup Language), 4

as default rendering, 7
embedded tags of, 203, 208–211
rendering extensions for, 14
viewer for . See also Access to reports

appearance of, 514, 525
displayed with reports, 513
for access to reports, 401–404
hiding, 509
searching reports with, 95–97

HTTP (Hypertext Transfer Protocol) log
configuring, 396
for Report Server monitoring, 386, 389–391
performance counters for, 391

HTTP 401 Access Denied errors, 383
HTTP Listener, 15
HTTP .SYS, 37–38
Hyperion Essbase, 14, 109

I
IF-THEN statements, 487
Iif program flow function, 162
IIS (Internet Information Services), 17, 389, 468
images, 66

embedded, 143
files for, 24
for report design, 132–133
in Report Server Project Wizard, 107
in Word document format, 422, 424

impersonating users, for security testing, 442–443
Import Query dialog box, 200
importing reports, 129
In operator, 198
Include Link check box, 466
incremental crawl schedules, 410
Indent property, 137
IdentifyingAttributes property, 285–286

infinite clickthrough, 22
inheritance, security, 346–347, 351, 360
Installation Progress page, 35
Installation Rules page, 35
installing Reporting Services, 21–63

accounts for, 26
configuration in, 35–46
deployment topology choice in, 23–24
edition choice in, 21–22
hardware and software requirements for, 24–25
prerequisites for, 27–28
Quick Reference guide on, 62–63
Report Builder 2 .0 in, 47
server mode choice in, 22–23
setup support files in, 28–29
SharePoint integrated mode configuration in, 49–62

add-in for, 52–53
ASPNET user permissions in, 61–62
content types for document libraries in, 60–61
for Report Server, 49–52
integration steps in, 53–56
Report Center site for, 58–60
Web application creation for, 56–58

SQL Server features in, 29–35
Windows Firewall in, 46

Instance Configuration page, 31
InstanceSelection property, 275
integrated mode . See SharePoint integrated mode
Integration Services, in SQL Server 2008, 5, 372
IntelliSense, 147, 157, 166
interactivity, 181–213

clickthrough feature for, 454
disabling, 452–454, 462
fixed header additions and, 184–185
in navigation features, 203–211

document map in, 204–205
embedded HTML tags for, 208–211
for jumping to reports, 205–208

in Report Builder, 451–452
in sorting, 181–184
of Excel spreadsheet format, 421
of HTML format, 419
of Word document format, 422
overview of, 5–6
parameters for, 188–203

as filters, 193–195
cascading, 200–201
dataset for values of, 195–197
displaying, 202–203
for user input prompt, 189–193
query, 197–199

Quick Reference guide on, 212–213
visibility control and, 185–188

Internet Explorer
caching reports and, 324
copying reports and, 313
parameter configuration and, 314
prompted credentials and, 318
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report access and, 343
Report Manager and, 10, 89
report models and, 276
Report Server Web service and, 40
stored credentials and, 320
testing security and, 348, 352, 354
to confirm deployment, 307
to download Report Builder, 47
to download sample databases, 48

intranet settings, 40
ISAPI (Internet Server Application Programming 

Interface), 17
item-level security, 346–358

for data sources in SharePoint integrated mode, 350
for folders, 346–350
for report models, 354–358
for reports, 351–352
system role in, 352–354

J
job schedules, 11
jobs, executing reports as, 373
Join function, 203
jumping to reports, 205–208

K
kanatype sensitivity, 113
Kerberos authentication, 16, 55, 57, 382
keys, encrypted, 381
keywords, for searching, 410
KPIs (key performance indicators)

Excel format and, 422
group variables for, 167
in dashboards, 416
in gauges, 5, 262
in Metadata pane, 220, 224–225

L
Label property, 203
labels

default, 119
in ad hoc reports, 445
on chart axes, 247, 253
parameter, 202–203, 213
value versus, 190

landscape orientation, 140–141, 405
Last function, 154
layout, 68, 105, 129 . See also Formatting
least-privilege accounts, 26, 379
legends, on charts, 242, 247, 266, 440
Level function, 175–176, 180
licensing

for native-mode topology, 23
for Report Builder, 47
for SharePoint integrated mode, 53

in Reporting Services installation, 29
of sample databases, 48

life cycle, reporting, 331
line charts, 243, 258, 439
linear data, charts of, 243–244
linear gauges, 263–267
LineHeight property, 137
lines, 131, 143
links, 6

Content Sources and Crawl Schedules, 410
Default Content Access Account, 410
deployment to servers and, 311–312
HTML, 203
in reports, 332, 359–360, 502–505, 523
parameter to query, 233
report parameter to query parameter, 197–199
to My Reports folder, 405–407, 428
to subreports, 134–135
to URL-access reports, 509–517

lists, 126–128, 137
load balancing, in scale-out deployment, 23
Location property, 135–136
lockdown strategy, 385
low memory pressure, 384

M
main procedure, 499–500
Manage Processing options, 323
managed reports, 4, 20, 47
Management Studio, 352–353
management tools, 11–12, 29–30 . See also 

administrative tasks
mapping, 14, 195, 360
maps, document, 6, 204–205, 213, 412, 421
margins, page, 117, 140, 405
matrixes

as data region, 123–126
chart similarities to, 245
gauge added to, 263–266
in lists, 126–128
interactivity disabling in, 452
Report Builder for, 432, 436–439
Report Server Project Wizard limited to, 105
Tablix versus, 10

Maximum function, 154
maximum memory setting, 384
MDX (Multidimensional Expression) query, 215

calculations added to, 223–226
constructing, 218
designer for, 219–223, 240

Measures object, 220, 222, 227
medium memory pressure, 384
memory

management of, 15–17
performance counters for, 391, 393–394
Report Server configuration and, 383–386
requirements for, 25
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Memory Broker, 384
Metadata pane, 220–222, 224
MHTML (MIME Encapsulation of Aggregate HTML 

Documents) files, 419–420, 466
Microsoft  .NET Framework technology

application domain layer hosting of, 16
for distributed deployment, 52
for SQL Server installation, 27–28
programming with, 491, 498
service platform support of, 16

Microsoft Office Performance Server 2007, 7
Microsoft Office Word, 14–15, 117, 422–424
Microsoft Public License message box, 216
Microsoft Reporting Services Add-in for SharePoint 

Technologies, 25
Microsoft Visual Basic, 137
Microsoft Visual Basic  .NET format string, 85
Microsoft Visual Basic  .NET Framework, 306
Microsoft Visual Basic  .NET programming language, 487
Microsoft Visual Basic  .NET scripts, 12
Microsoft Visual Studio, 9, 104, 276, 491
Microsoft Windows Installer, 27
MIME HTML (Mulitpurpose Internet Mail Extensions 

Hypertext Markup Language), viewing reports 
as, 117

Minimum function, 121, 154
minimum memory setting, 384
minus sign, to hide report items, 187
Model Designer, 9, 272, 278
model item security, 356, 442–443
model objects, organizing, 280–282, 295
moving average convergence and divergence (MACD), 

for financial charts, 254–256, 266
MSRS 2008 Web Service object, 391
MSRS 2008 Windows Service object, 391
multidimensional data structure, 5, 215 . See also cubes, 

OLAP (online analytical processing) database as
multi-value data, charts of, 245
My Reports folder

Content Manager role similar to, 372
for access to reports, 405–407
linked reports for, 428
SSMS and, 370–371

My Subscriptions page, 479–480

N
named query, 270, 273–274
naming conventions, 31
native mode, Reporting Services in

as default configuration, 34
authentication configuration on, 383
Content Manager role in, 299
deployment scripts for, 498–502
editions of, 62
installation in, 22–24
linked report scripts for, 502–505
overview of, 7

publishing reports in, 87–88
Report Builder access in, 430
Report Manager for, 10, 63
report model deployed to, 290–291
security in, 338–340, 359–360
SharePoint partial integration with, 62
subscription schedules and, 477
system user roles for, 353–354
TargetDataSourceFolder in, 300
viewing reports in, 95–96

navigation
document map for, 6, 204–205
embedded HTML tags as, 208–211
for jumping to reports, 205–208
HTML Viewer for, 401
in SharePoint document libraries, 60

nesting
bookmarks in groups, 204
folders, 307, 400
gauges in matrixes, 263–266

Network Load Balancing (NLB), in scale-out 
deployment, 23

networking, 16, 26
NoDataMessage property, 245
nonadditive values, 229–230, 240
NoRowsMessage property, 199
Notepad, 377, 426–427
Now function, 167–168
NTLM (NT LAN Manager) authentication, 16, 57, 382
Null Delivery Provider extension, 14, 473
numbers, formatting, 68, 249 . See also Charts
numeric attributes, 279

O
Object Explorer, 217

databases folder in, 361
disk usage review and, 387
Jobs folder in, 373
personalized folder enabling and, 317
security folder in, 339, 353
SSMS and, 370

Object Model Statistics page, 275
ODBC (Open Database Connectivity), 14, 30, 109, 111, 

218
Office . See Excel spreadsheets; Microsoft Office Word
Office SharePoint Server, 23
OLAP (online analytical processing) database, 215
OLE DB (Object Linking and Embedding Database), 14, 

30, 69, 109, 111
on-demand execution of reports, 6

disabling, 386
in deployment to servers, 322–323, 333
Report Processor for, 13

options, in datasets, 113
Oracle databases, 9, 14
ORDER BY clause, 160
Order drop-down list, 126
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orientation, page, 117
out-of-memory exception, 383
Output window, 117
OverwriteData Sources property, 317
owner permission, 470
owners role, 299

P
Padding property, 136, 162
page breaks

in tables, 120
inserting, 82–84, 98
setting, 138–139, 144
soft, 421

page file size, 383
page layout, 4 . See also formatting
page numbers, 153
Page Setup button, 117
PageSize property, 140–141
paging, rendering formats and, 15
paragraph alignment, 68
parameters . See also query parameters

for Analysis Services, 233–239
custom query, 236–239
in datasets, 233–236

for deployment to servers, 314–317, 333
for interactivity, 188–203

as filters, 193–195
cascading, 200–201
dataset for values of, 195–197
displaying, 202–203
for user input prompt, 189–193
query, 197–199

in Report Server Project Wizard, 107
report, 66
Report Viewer and, 413
simple report, 180
static available values for, 212
to filter content, 6

Parameters collection, 169
parent gauges, 263
parent groups, 129
parent reports, 462
parent row groups, 98
parent security, 347
parentFolder variable, 499
parentPath variable, 499
passwords

encrypted keys and, 381
expired, 377
for subscriptions, 472
in data source creation, 110
in Reporting Services installation, 45
in SharePoint search function, 409–410

PDF (Portable Document Format) files
as Reporting Services feature, 4, 7
disk space requirements of, 24

rendering extensions for, 14
viewing reports as, 117, 424–425

percentage format, 150
performance

counters for, 386, 391–394, 396
delivery, 8
fine-tuning, 6

Performance Console, 391
permissions

ASPNET user, 61–62
authentication granting of, 336
Change, 469
for My Reports folder feature, 372
for personalized folders, 317
for report model security, 354–355
for report retrieval, 108
for Reporting Services accounts, 26
for SharePoint search function, 408
in item-level security, 348
in report life cycle, 331
management of, 12
Owner, 470
SharePoint, 340–342, 344–345
stored credentials and, 320
table for, 360–363
to add content, 304

personalized folders, 317
Perspective property, for charts, 441
pie charts, 244, 439
pixel-perfect reports, 135
placeholders, for subreports, 134
platform, reporting, 3–5, 20
plus sign, for report item visibility, 187
pointers, in gauges, 263–264, 267
polar charts, 244
policies, security, 335–342

authorization, 337–338
implementing, 336
in native mode, 338–340
in SharePoint integrated mode, 340–342

Population standard deviation function, 154
Population variance function, 154
portal applications, 7
portrait orientation, 405
Prepare Query toolbar button, in query designer, 222
preprogrammed reports, 3
previewing reports, 5, 98, 143

ActiveX controls for, 404
for print-ready formats, 140
in Report Designer, 117
Output window for, 117
simple reports, 86–87

primary key column, in tables, 173–174, 272
Primary Site Collection Administrator, 313
printing

accessing reports for, 404–405, 428
client-side, 370–371
delivery extensions for, 14

 printing 541



exporting reports for, 424–425
formatting for, 139–141
page layout for, 4
print layout for, 117, 446
Report Manager for, 10
Report Viewer and, 414

processor components, 13
Product Key, in Reporting Services installation, 28
production environment, 62
programming, 9

management, 12
Quick Reference guide for, 522–525
report design components, 487–496

assemblies of custom code for, 491–496
embedding code for, 487–491

report server management, 497–509
deploying reports in, 498–502
linking reports in, 502–505
WMI provider for, 506–509

reporting access, 509–521
ReportViewer control for, 517–521
URL, 509–517

to view reports, 11
prompt for user input, 189–193
Properties pane, 67, 85, 98, 116
public keys, 381
publishing

centralized store for, 4
command-line utilities for, 12
management of, 87–88
report models, 289–293
simple reports, 99

pyramid charts, 244

Q
queries

clickthrough report, 455–456
MDX (Multidimensional Expression), 215
named, 270, 273–274

Query Designer
adding datasets and, 72–73, 111–113
expressions and, 173
MDX (Multidimensional Expression) queries in, 218
query parameters in, 221
report parameter values and, 195
securing data and, 362, 364

query language, 4
query parameters

calculations added to, 223–226
Calendar Year values retrieved by, 438
custom, 236–240
for Analysis Services, 219–223
for interactivity, 197–199
for security of content, 359–360
importing, 200
in query designer, 221
report parameters linked to, 213
Value default passed to, 190

query strings, 71, 105
query types, stored procedure as, 111
Quick Reference guide

on access to reports, 428
on ad hoc reports, 461–462
on administrative tasks, 395–396
on Analysis Services, 240
on deployment to servers, 332–333
on designing reports, 142–144
on expressions, 179–180
on installing Reporting Services, 62–63
on interactivity, 212–213
on programming, 522–525
on report models, 295–296
on Reporting Services introduction, 20
on security of content, 366–368
on simple report development, 98–99
on subscriptions, 482–483
on visualizing data, 266–267

quotation marks, as text qualifiers, 427

R
radar charts, 244
radial gauges, 263
range charts, 245
ratio data, charts of, 244
RDL (Report Definition Language) files, 9, 123, 501, 522
readability, improving, 85
Ready to Install page, 35
recursive hierarchies

Aggregate function and, 177–178
grouping, 174–175, 180
levels in, 175–176, 180

refreshing Metadata pane, 221
refreshing report models, 293
relational databases, 5, 9
Reliability and Performance Console, 391
remote report server, 291
remote SQL Server, 24, 26
Remove Prompt command, 449
rendering reports

alternate formats for, 525
background processing management of, 16
execution for, 93, 321
explanation of, 4
extensions for, 14
HTML as default, 7, 419
HTML Viewer and, 513
in CSV (Comma Separated Values) format, 425
in Excel format, 421
memory requirements for, 383
page breaks in, 138
programmatic interface for, 11
quick reference on, 20
Report Manager for, 10
subscriptions for, 471, 474–475
testing of, 107

repetitive tasks, 5, 12
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Report Builder, 9
disabling, 386
EnableDrillthrough property in, 286
entity instances and, 285
for ad hoc reports, 4, 429–443, 461

chart building in, 439–442
introduction to, 430–433
matrix building in, 436–439
security testing in, 442–443
table building in, 433–436

for simple report development, 66–68
GUIDs in reports and, 293
in Reporting Services installation, 47
opening, 98
overview of, 9–10
permissions for, 355–358
report models and, 277
Ribbon interface in, 107
Semantic Model Definition Language (SMDL) and, 276
SortDirection property and, 280

Report Center
permissions for, 408
searching in, 411
site for, 58–60

Report Designer, 9, 103–114
data sources created in, 108–111
datasets created in, 111–114
message display by, 199
overview of, 10
previewing reports in, 117
RDL (Report Definition Language) files in, 123
Report Builder versus, 439
Report Server project in, 104–105, 107
reports added in, 105–108
testing functions in, 491

report items
definition of, 67
expressions for, 150–152
placement and size of, 135–136, 143
properties of, 136–138

report management, 87–94
descriptions in, 88–92
execution properties in, 92–94
publishing in, 87–88

Report Manager
disabling, 386
execution properties page opened in, 92–93
for access to reports, 399–407

HTML Viewer for, 401–404
My Reports folder for, 405–407
to print, 404–405
to search for reports, 400–401

HTML as default format in, 419
in service architecture, 16
in SharePoint integrated mode, 49
management tools in, 11–12
report description added in, 89–90
Report Server Configuration Manager and, 376
viewing reports in, 10, 95

Report Model Wizard, Calendar Year recognition  
by, 438

report models, 269–296
attribute appearance properties in, 282–283
changes in, 293–295
data source added to, 269–270
data source view added to, 270–274
description of, 4
drillthrough reports and, 286–289
entity instances and, 285–286
expressions for, 283–285
for clickthrough reports, 459–462
item-level security for, 354–358
management of, 12, 276–277, 289
memory management and, 383
organizing model objects in, 280–282
publishing, 289–293
Quick Reference guide on, 20, 295–296
Report Model Wizard for, 274–276
Report Processor and, 13
reviewing, 277–280

report processing extensions, 14
Report Processor, 13, 71
Report Server, 19, 497–509

as application database, 386
configuration of, 376–386

authentication in, 382–383
encrypted information in, 377–381
memory management in, 383–386

deploying reports in, 498–502
disabling features of, 385–386
in SharePoint integrated mode configuration, 49–52
linking reports in, 502–505
monitoring of, 386–394

for application database size, 386–387
HTTP log for, 389–391
performance counters for, 391–394
trace logs for, 387–389

Report Designer and, 104–105
status page of, 36
URL reservation for, 37
WMI provider for, 506–509

Report Server Database Configuration Wizard, 50–51
Report Server Model Project template, 104
Report Server Model, as data source, 69, 109
Report Server project, 142
Report Server Project Wizard, 104–105
Report Server Web Service, 16
Report Server Windows Service, disabling, 386
Report Viewer

dashboards and, 428
HTML as default format in, 419
in SharePoint integrated mode, 412–415
overview of, 10–11

Reporting Services Configuration Connection dialog 
box, 35

Reporting Services Configuration Manager . See also 
Report Server

for administrative tasks, 369
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in installation, 36–37
in scale-out deployment, 46
overview of, 11–12
WMI provider for, 506

Reporting Services Configuration Tool, for  
accounts, 26

Reporting Services, introduction to, 1–20
access to, 7
administration in, 6–7
architecture of, 7–19

application tier in, 9–12
data tier in, 8
for SharePoint integrated mode, 17–19
server tier in, 13–17

development in, 5–6
quick reference guide for, 20
reporting platform in, 3–5

Reports Library, 415
reports variable, 500
ReportServer config file, 395
ReportServer Service object, 391
ReportServerTempDB database, 8, 13, 322, 324,  

386–387
ReportViewer control, 517–521, 525
ReportViewer Web server control, 471
repository, for reports, 7
request queue, URL reservation and, 37
resizing images, 133
resizing reports, 10, 143, 404
reusability of code, 491
Ribbon interface, in Report Builder, 66–67, 76, 107
roles . See also Content Manager role; also permissions

assignments of, 342–344
authorization system based on, 336
in report models, 277
security of, 354

root site collections, 313
rotating chart labels, 253, 266
rotation properties, for charts, 441
Row Groups section, 77, 82, 185
Row Visibility dialog box, 186
RPC (Remote Procedure Call), in services architecture, 16
RPL Renderer, 471
Rs command-line utility, 12, 306–307, 332, 497–498, 

501, 523
Rs2008sbs .VB .Extensions .dll assembly file, 494
Rsconfig command, 377–381
Rsreportserver .config file

authentication and, 382–383
connection information in, 377
editing, 376–377
memory management in, 384–385

 .rss file extension, 306
RSWindowsKerberos authentication type, 382
RSWindowsNegotiate authentication type, 382
RSWindowsNTLM authentication type, 382
rulers, 67, 130
Run command, 68
RunningValue function, 154, 157–160

S
SAP Netweaver Business Intelligence, 14, 69, 109
saving reports, 120, 329–331
scalar values, of attributes, 288
scale breaks, in charts, 250–253, 266
scale-out deployment, 22

authentication limits in, 16
Configuration Manager for, 11–12, 46
data tier requirements for, 8
multiple report server instances created in, 23

scatter charts, 244
schedules

background processing management of, 16
Content Sources and Crawl, 410
disabling, 386
for snapshot reports, 326–329, 376
Gantt charts for, 245
pausing shared, 373
Shared Schedule Manager for, 353
stored credentials and, 320
subscription, 466, 469, 478, 483

Scheduling and Delivery Processor, 13–14
Scope argument, 151, 154–157, 175
scripts

for subscription delivery table, 474–475
Microsoft Visual Basic  .NET, 12
permissions table and, 361
Rs utility for, 523
to deploy reports, 306–307, 498–502
to execute repetitive tasks, 5
to link reports, 502–505
tools for, 11

scrolling, fixed headers to avoid, 184
searching

configuration for, 407–410
for report strings, 97
HTML Viewer for, 401
in SharePoint integrated mode, 410–412, 428
Report Manager for, 10, 400–401
report server content, 428

second chart area, 260–262, 267
secondary axes, in charts, 10, 256–258, 266
security . See also authentication

administration of, 6
custom extensions for, 14
encrypted keys for, 381
implementing, 5
in SharePoint integrated mode, 17
in SharePoint Web applications, 57
lockdown strategy for, 385
programmatic interface for, 11
Report Builder testing of, 442–443
reports requiring none, 71
URL access and, 516
Windows integrated, 317

security of content, 335–368
implementing, 358–365

dataset filter for, 364–365
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permissions table for, 360–363
query parameter and role for, 359–360

item-level, 346–358
of data sources in SharePoint integrated  

mode, 350
of folders, 346–350
of report model, 354–358
of reports, 351–352
system role in, 352–354

permissions for, 342–345
policies for, 335–342

authorization, 337–338
implementing, 336
in native mode, 338–340
in SharePoint integrated mode, 340–342

Quick Reference guide on, 366–368
Security Source Query report, 363
SELECT clause, 146
Select Model Generation Rules page, 275
self-referencing join, table with, 173
Semantic Model Definition Language (SMDL),  

276, 289
series drop zone, 246
series, chart, 242
Server Application Unavailable error message, 60
server extensions, 13, 20
servers

as architecture tier, 13–17
configuration of, 31–32
deployment to, 299–333

caching reports in, 324–325
copying reports in, 313–314
data source properties in, 317–321
folders to organize content in, 307–308
moving content in, 309–311
of linked reports, 311–312
of report projects, 300–304
on-demand execution of reports in, 322–323
parameters configured for, 314–317
Quick Reference guide on, 332–333
reporting life cycle and, 331
Rs utility for, 306–307
snapshot reports in, 325–331
uploading reports in, 304–306

managing resources of, 5
mode choices for, 22–23
single, 26, 49
Web front-end, 24

service accounts, 12
service architecture, 15–17
Service Credentials authentication, 52
service platform, 16
Set Expression For Value box, 147, 156, 172
setup support files, for Reporting Services installation, 

28–29
shadow options, 242
shared data sources

assigning, 523
creating, 109–111, 142

disabling, 374–376
folder for, 218
for subscription delivery tables, 476
in report models, 277
Report Project Wizard and, 105

Shared Schedule Manager, 353
shared schedules, 326, 373, 469, 478, 483
SharePoint configuration database, 19
SharePoint content database reports, 19
SharePoint document library, subscriptions and, 473
SharePoint integrated mode

access to reports in, 407–419
dashboards for, 415–419
Report Viewer for, 412–415
search configuration for, 407–410
searching for reports in, 410–412

architecture of, 17–19
as default configuration, 34
configuration of, 49–62

add-in for, 52–53
ASPNET user permissions in, 61–62
content types for document libraries in, 60–61
for Report Server, 49–52
integration steps in, 53–56
Report Center site in, 58–60
Web application creation in, 56–58

Data Connections library in, 276, 301
execution properties page opened in, 93–94
installation in, 22–23
overview of, 7
Owners role in, 299
publishing reports to, 88
Report Builder access in, 430
report description added to document library of, 

90–92
report model deployed to, 291–293
Report Viewer in, HTML as default format in, 419
Reporting Services Configuration Manager and, 12
Reporting Services editions in, 62
search configuration for, 428
security in, 336, 340–342, 359–360
subscription schedules and, 477
switching to, 41
viewing reports in, 10, 95–96

SharePoint server, 19
SharePoint Web farm administrators, 54
sharing reports, by publishing to centralized store, 4
Show Aggregations toolbar button, in query  

designer, 221
Show Empty Cells toolbar button, in query designer, 221
show-hide display, 67
simple expressions, 145, 179
simple reports, developing, 65–87

data sources for, 69–71
datasets for, 71–73
formatting, 84–86
grouping data for, 79–82
page breaks for, 82–84
previewing, 86–87
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quick reference guide for, 98–99
Report Builder for, 66–68
tables for, 75–79
titles for, 74–75

site collections, 54, 59, 88, 313
Size property, 135–136
SMTP (Simple Mail Transfer Protocol), 11–12, 43, 376, 

464, 468
snapshot reports, 6

ChunkData table and, 386
created on schedules, 376
disk space and, 24
execution properties to implement, 92, 94
in deployment to servers, 325–331
in Report History, 372
memory management and, 383
Report Processor for, 13
Scheduling and Delivery Processor for, 13
subscriptions and, 467
suspending, 373

SOAP (Simply Object Access Protocol) endpoint, 19
soft page breaks, 421
software requirements, 24–25
Solution Explorer

Calendar Control in, 237
chart creation and, 245, 254, 256, 258, 260
dashboards and, 415
data source view and, 271
deployment path changes in, 217
for clickthrough reports, 458
for detail rows, 231
in expression development, 146, 155, 160
in report design, 105, 107, 111, 123, 129, 134, 138
interactivity and, 182
report model deployment and, 290
securing data and, 362, 365
Shared Data Source folder in, 218

SortDirection property, 280, 282
sorting

chart series, 266
default order of, 126
expressions for, 159–162, 179
gauges and, 263
grouping and, 120, 143
in ad hoc reports, 451–452, 462
interactive, 181–184, 212

SpaceAfter property, 137
SpaceBefore property, 137
sparkline charts, 243
SPN (service principal name), 382
SQL Server . See also Business Intelligence Development 

Studio (BI Dev Studio)
as data source, 69, 109
CLR integration of, 16
data processing extensions for, 14
installing features of, 29–35
Integration Services of, 5
jobs of, 13
Remote, 24

Reporting Services in, 3
service platform and, 16

SQL Server 2008 Analysis Services RTM Samples Setup 
Wizard, 216

SQL Server 2008 Developer, 22, 454, 474
SQL Server 2008 Enterprise, 22, 454, 474
SQL Server 2008 Evaluation, 22
SQL Server 2008 Express with Advanced Services, 21
SQL Server 2008 Standard, 22
SQL Server 2008 Web, 22
SQL Server 2008 Workgroup, 22
SQL Server Agent service, 32, 464
SQL Server Books Online, 29–30, 391, 419, 468
SQL Server Configuration Manager, 11
SQL Server Credentials, 52
SQL Server Installation Center, 27–28
SQL Server Management Studio, 11–12, 317, 474–475
SQL Server Surface Area Configuration, 37
SSL (Secure Sockets Layer) certificates, 38
SSMS (SQL Server Management Studio)

disk usage reviewed in, 386–387
Report Server configured in, 370–373

SSP (Shared Services Provider), 409
stacked area charts, 244
Standard deviation function, 154
star schema design, 48
static available values, for parameters, 189–192
static text boxes, 130
status bar, in Report Builder, 68
StatusType argument, 489
stock charts, 245, 254–256
storage

for report history, 331
of credentials, 320–321
Report ServerTempDB for, 387
scalable, 14
SOAP (Simply Object Access Protocol) endpoint and, 

19
stored procedure, as query type, 111
string fields, 128
string values, aggregate functions for, 154
strong passwords, 45
styles, 84, 136–137, 208–211 . See also formatting
subreports

adding, 143
definition of, 67
linking information in, 134–135
mapping report parameters to, 195

subscriptions, 463–483
background processing management of, 16
data-driven, 22, 474–478
deleting, 480–481
delivery formats for, 7
e-mail, 43, 464–468
management of, 12
memory management and, 383
My Subscriptions page for, 479–480
Null Delivery Provider, 473
parameter values and, 190
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Quick Reference guide on, 482–483
Scheduling and Delivery Processor for, 13
shared schedule for, 478
SharePoint Document Library, 473
suspending, 373
Windows file share, 469–473

SUM function, 121, 128, 151, 154, 156, 161, 229, 446
surface area, reducing, 385
Switch function, 172
switch program flow function, 162, 164
Switches section, in configuration files, 388
symmetric keys, 381
system role, in item-level security, 352–354

T
TableDirect feature, 111
tables . See also Data Source View (DSV)

Analysis Services dataset for, 226–227
as query type, 111
chart legends in, 248
ChunkData, 386–387
fields added to, 115–117
for simple reports, 75–79
grouping data in, 79–82, 117–121
in named query, 270–271
insert command for, 98
permissions, 360–363
Report Builder for, 432–436
report models to describe, 4
Report Server Project Wizard limited to, 105
self-referencing join in, 173
star schema design and, 48
subscription delivery, 474–475
tablix versus, 10

tablix, 129
data region for, 10, 79
expressions in, 149
Group dialog box for, 118, 130
in Properties window, 116
recursive hierarchy groups in, 174
RunningValue function in, 157–160

target locations, for report display, 205
target zones, gauges and, 263
TargetDataSourceFolder, 300, 415
TargetReportFolder, 415
TargetServerURL, 415
templates

in Report Center site creation, 59
project, 104, 106
Report Designer, 9

temporary formats, 13
Teradata databases, 9–10, 14, 109, 270
testing

applications with ReportViewer, 520
functions, 491
reports, 331
security, 348, 352, 354, 442–443
TestNow function for, 168

text boxes
controls for, 155, 202
expressions in, 149–150, 179
for report item visibility, 186
free-form, 5
Go To Report action in, 206–208, 213
in lists, 126–128
in report design, 130–131
report item for, 10
text appearance in, 143
visibility of, 212

text qualifiers, 427
TextAlign property, 137
third-party client-side reporting tools, 3
thread processing, 16
Threshold argument, 489, 493
TIFF (Tagged Image File Format) files, 7, 117, 424
time periods, as category axis of charts, 243–244
time-out settings, 113, 372–373
time stamps, expressions for, 167
titles

adding, 130–131
chart, 242, 248, 266, 440
in page headers, 74–75, 141
static, 143

Toggleitem property, 185
toolbars, in report viewers, 10
Toolbox window, 107–108, 114, 155, 202, 263
totals, 121–123, 143
trace logs

for HTTP activity, 389–391, 396
for Report Server monitoring, 386–389
settings for, 396

transactional databases, 48
tree form, bookmarks displayed in, 204
tree view, of Model Designer, 278
trends, charts for, 241, 260
troubleshooting

client connectivity, 390
subscriptions, 468
trace logs for, 387–388

Trusted Account mode, 26, 55
Try-Catch block, 499, 501, 504
T-SQL (Transact-SQL) statements, 146
Tufte, Edward, 243
Type argument, 489

U
unattended execution, 12, 63
Undo button, 116
unicode text, 306
Universal Naming Convention (UNC), 469
uploading reports, 304–306, 332
URL access to reports, 509–517, 524
URL endpoints, 12
URL reservations, for report server Web service, 37–38, 

40, 42
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users
impersonating, 442–443
prompt for input from, 189–193
Role Properties for, 339

UTF-8 text, 306

V
validating reports, 348
value (y) axis, in charts, 242
Value property, 147
values

chart for distributions of, 244
for parameters, 189–192
formatting, 227–229
in range charts, 245
scalar, 288

variables, 120
for calculated expressions, 10
group, 179
in expressions, 164–168
report, 180

Variance function, 154
Verbose mode, for trace logs, 388
versioning, 17, 305, 371, 473
Vertical rotation property, 441
viewing reports, 95–97, 99, 509–514
views, in Report Builder, 68
virtual directories, 37–38, 302, 376
visibility, 212

control of, 185–188
dynamic, 427
interactivity and, 212
of charts, 242, 247
of parameters, 169, 190

Visual Studio 2008, 517
visualizing data, 241–267

charts for, 241–262
calculated series in, 254–256
column, 245–247
combining types of, 258–260
formatting, 247–250
of linear data, 243–244
of multi-value data, 245
of ratio data, 244
overview of, 242
scale breaks in, 250–253
second area in, 260–262
secondary axis in, 256–258

gauges for, 262–266
Quick Reference guide on, 266–267

W
Wall thickness property, for charts, 441
warning zones, gauges and, 263
Warnings variable, 499

Web applications, in SharePoint integrated mode 
configuration, 56–58

Web front-end servers, 24
Web Parts

adding, 416
Excel Web Access, 416
for embedding reports, 10
for report viewing, 18
in dashboards, 415
native mode use with, 22
Report Viewer, 417, 428

Web service, 12
Web service, configuring, 63
Web, reporting applications for, 4
WHERE clause, 113, 197–198, 201, 455
WHILE statements, 487
white space, 140, 144, 260
width sensitivity, 113
Windows authentication, 14, 55, 109, 170, 218, 317, 339
Windows Credentials, 52
Windows Explorer, 61
Windows file share subscriptions, 469–473, 482
Windows Firewall, in Reporting Services installation, 46
Windows groups, 344–345
Windows Performance Console, 391
Windows XP, Windows Firewall configuration in, 46
WITH clause, 224
WMI (Windows Management Instrumentation), 16, 28, 

506–509
WMIQueryVB .ext file, 509
Word . See MIcrosoft Office Word
workflows, 17
workflows, for dashboard approval, 419
Workspace folder, for subscriptions, 471
World Wide Web Consortium (W3C), 389
WOW 64 (Windows on Windows 64-bit) mode, 25
wrapping text, 183, 426
WSDL (Web Services Definition Language), 498

X
x axis, of charts, 242
XML (Extensible Markup Language), 7

as data source, 69, 109
exporting reports in, 425–427
rendering extensions for, 14
RSreportserver .config file in, 377
Semantic Model Definition Language (SMDL) and, 276
viewing reports in, 117

Y
y axis, in charts, 242

Z
Zoom factor, 10, 401, 403, 413, 425
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